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WELCOME TO FLEET COMPLETE 
 

This on-line help system explains how to use Fleet Complete to: 

• track, on a single screen, the real-time location, speed, and direction of travel of all 
vehicles in your fleet 

• distinguish between events and asset activities that occurred during working hours 
from those that occurred on personal time 

• record when assets (with in-vehicle devices, handheld devices, or asset tags) enter or 
exit an identified location 

• capture vehicle information such as state of ignition, battery voltage, or PTO sensor 
reading, and more 

• create rules that can identify inappropriate driver behaviour, such as harsh braking or 
speeding, or use of a vehicle outside of work hours, so you can take corrective actions 

• produce powerful operational and management reports that show vehicle activities 
throughout the day, allowing you to analyze the congregation or overlapping of assets, 
idling or stop time, speeding patterns, and more 

• create activities and assign them to resources to be performed 

Every function and feature of Fleet Complete is described in this help system. Keep in mind 
that the security profile that your user account is assigned to might not grant you access to all 
of Fleet Complete's functions. 
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GETTING STARTED 
 

About Fleet Complete Data Collection 
 

Devices 

Every asset you can track in Fleet Complete has some type of GPS-enabled device: 

• vehicles and other equipment with an engine have an in-vehicle device 

• individuals have a mobile phone (GPS and/or LBS-enabled handheld device) 

• equipment may have an asset tag 

Your organization may also make use of sensors (for example, a sensor to indicate whether or 
not a door is open), including those that collect and transmit information about a PTO (for 
example, to record when a beacon was on while the vehicle was painting lines on a road). 

Vehicles may also have an ECM box that records diagnostic trouble codes and engine 
information. 

Both sensors and ECM boxes communicate information to the in-vehicle device, which 

transmits it to the server along with the GPS data. 
 

Collection and Transmission of Data 

Data is collected and stored on the device at intervals, then transmitted to the Fleet Complete 
server (when in cell coverage) at either the same or a different interval (typically each 
transmission includes multiple snapshots of data): 

• in-vehicle devices and GSP handheld devices collect and transmit data at configurable 
intervals, with the option to collect and transmit additional data each time the vehicle 
changes direction or each time a specific set of conditions is in effect 

• LBS handheld devices and asset tags collect and transmit data at hard-coded intervals 

ECM data is sent to the in-vehicle device and to Fleet Complete when there any DTCs and 
again when the engine starts and stops. 

 

About Fleet Complete Data Storage 
Asset-related data is stored in Fleet Complete for a limited period of time (typically, three 
months). To capture and store information outside of Fleet Complete, use scheduled 
Operations reports and/or the data export function. Data used for Management reports (a beta 

feature) is kept for a contractual period of time. 

 

Using Fleet Complete to Meet Your Needs 
Fleet Complete is a powerful and flexible system that can bring greater efficiencies to your 
organization. To make the best use of Fleet Complete, you first need to understand some of 
the basic concepts involved and how they relate to your needs and requirements. 

 

Controlling Access to Fleet Complete Functions 

To determine which users can have access to Fleet Complete, the functions they can perform, 
and the scope of information available to them, you configure user accounts with assigned 
security profiles. 

 

Making Data Meaningful 

Raw data is collected from assets at intervals. You can make that data more meaningful for 
your specific needs by implementing the features described below. 

To distinguish between data collected during times when an asset is expected to be working 
from times when it is being used on personal time, use work schedules. 
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To capture meaningful information about driver behaviour (such as harsh braking or 

speeding), or to collect data that will help you save money (such as knowing when assets are 
used outside of scheduled working hours), use rules. 

To track and report on the activities of people, or to use MDT messaging, set up resources. 

To be aware of the interaction of assets with geographical areas of particular interest, use 
POIs. POIs might be locations where assets and resources are supposed to be (for example, 
client sites, warehouses, border crossings) or where they are not supposed to be (casinos, 
coffee shops). 

 

Taking Advantage of Additional Functions 

Use the Activities function to create location-specific activities such as service calls, assign 

them to resources/crews, and monitor their progress. 

Use the Maintenance function to track and manage asset maintenance (safety checks, oil 
changes). 

 

Considering Reporting Needs 
Fleet Complete offers a full range of reports that can be generated manually or based on a 
schedule. 

We Recommend Before you begin configuring your system, take a moment to review the list 

of available reports. Seeing how report data is organized and presented in Fleet Complete can 
help you make better configuration choices. 

 

About the Interface 

In Fleet Complete, you navigate to functions using the main menu (click ) or ribbon toolbar. 
Function windows open as tabs: to close any tab, click the x on the far right of a tab to close 

it. 

When you log on to Fleet Complete, you see the Welcome screen, as well as the last function 
screen you opened in your previous session. To re-display the Welcome screen, on the main 

menu, click Welcome. 

Function screens display data on a grid. 

Depending on your user account and system configuration, you may see an Alert panel on the 
right side of the main window. 

You can customize the interface to suit your preferences. 

 

Configuration Steps 
As a best practice, you should configure Fleet Complete in the following order: 

1.  Create asset work schedules that help your organization distinguish between when a 
vehicle is being used for business purposes and when for personal use. 

2.  Create asset types to group similar assets for reporting purposes and to limit user 
access (through security profiles) based on asset type. 

3.  Modify the default asset configuration to take advantage of your specific work 

schedules, vehicle information, and asset types. 

4.  Set up rules to monitor driver behaviour, sensor readings, and other critical 
information. 

5.  If you want to track when assets enter or exit a specific geographic area, set up POIs. 

6.  If you are using an MDT device or driver ID Fob, or will be dispatching activities to 

handhelds, set up resources and crews. 

7.  If you want to monitor and manage your assets' maintenance schedule, set up the 
Maintenance function. 

8.  To provide access to Fleet Complete for users, set up users and security. 

Before doing extensive data entry at any stage, consider the need for custom fields and, if 
necessary, set them up. 
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TRACKING 
 

Background 
 

About Tracking 
 

Why Use This Function? 

Tracking allows you to monitor the real-time activities and locations of assets. Even if you 

have not done any Fleet configuration, you can begin tracking immediately, using the default 
configuration provided by Complete Innovations. Tracking also lets you monitor and manage 
activities. 

 

What is the Default Configuration? 

By default, the Tracking screen shows all the assets you have access to . 
 

What Do I Need to Understand About Tracking? 

The Tracking function is integrated with the Fleet configuration function: you can edit or add 
to your configuration from the Tracking screen. 

Note: Not all configuration functions are available from within Tracking. For example, you 
cannot configure rules from the Tracking screen. 

 

About the Tracking Screen 

To open the Tracking screen, on the ribbon toolbar or main menu, click Fleet > Tracking. 

The Tracking screen is made up of the following: 

• a Command Bar of icons 

(icons become available depending on what is selected in the Map Items area) 
 

 
 

• a Map Items panel 

 
 

• a map with map controls 

 
 

• an activities panel 

• a messaging panel 

Note: You can open and close the panels to allow you to focus on information of interest. 

The Map Items area is made up of several sections: 
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• on the Activities panel 

• a tree of items that are displayed, or available to be displayed, on the map 

• details on the selected item (the one you have clicked on most recently on the map or 

Map Items tree) 

Note: You can drag the divider between the tree and details sections of the Map Items area to 
change the height of each section. 

The map shows selected assets, POIs, and/or custom layers. 

Features available from this screen include: 

• activating/deactivating output 

• adding a POI 

• assigning resource or run to an asset 

• changing item or type configuration 

• being informed when an asset moves (departure notification) 

• controlling which items appear on the map 

• displaying place details 

• focusing the map display 

• following an asset in a new window 

• locating the closest assets to a specific location or other asset 

• printing the map 

• replaying trips of assets 

• requesting the current position of an asset 

• setting map options 

• setting the unit of measurement for the map 

• showing additional map information (custom layers, labels, and/or traffic) 

• viewing details of an asset's recent activities 

• viewing events 

• working with the Activities panel 
 

Working with the Map 

The map portion of the Tracking screen shows the location of assets and POIs, along with any 
custom layers you have configured and chosen. By default, the map shows all configured 
assets that have an active device, and all configured POIs. However, you can control which of 

these appear on the map. 

Assets and circular POIs are displayed showing the icon configured for their type; other POIs 

are displayed showing the colour configured for their type along with an information icon . 

Note: If an asset is in more than one POI, only the POI that takes up the smallest area is 

shown. 

LBS devices are shown in a peach-coloured circle that represents the possible location of the 
device: the diameter of the circle indicates the radius of accuracy of the LBS signal. 

Hovering the cursor over an item on the map opens a pop-up containing detailed information 

about the item or, if icon clustering is enabled, about the cluster. 

Clicking an item in the Map Items panel focuses the map around that item (which is 

surrounded by a yellow circle) or, if icon clustering is enabled, around the cluster in which the 

item is situated. As the selected asset moves, it may move out of sight on the map, unless the 
follow selected asset option is enabled. 

The map controls offer features similar to those of many online maps: 

• to move the map area, click on the map and drag it until the desired section is shown, 
or use the pan control 

 
 

• to zoom in or out, use the zoom controls or your mouse's scroll wheel 
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• to change the map view, use the view controls 

 
 

To hide these controls, click << (to the right of the view controls); to show them again, click 
>>. 

To find a specific location on the map (address, latitude/longitude, or LSD), enter location 
information in the right-hand search box above the map and press ENTER. To clear your entry, 
click X. 

To find a specific asset, resource, or POI on the map, enter all or part of the name of the item 
in the left-hand search box above the map and press ENTER. If more than one match is found, 
you see a list of search results: double-click on the item of interest to locate it on the map. 

 

About the Map Items Panel: Tree 
 

Contents of Tree 

The tree portion of the Map Items panel on the Tracking screen shows configured assets, 
POIs, and custom layers in a tree structure, with assets and POIs grouped by type. Asset 
types are identified by name, along with the icon configured for that type (the same icon is 

also used to represent assets of that type on the map). 

Note: If an asset type or POI type has no associated assets or POIs, it is not shown. 
 

Depending on the option chosen (click in the top right portion of the screen to open the 
map options and check the desired Display Asset As option), the list may show asset name 
followed by the asset's resource in square brackets, or the resource followed by the asset's 
name in square brackets. Choose the display option that meets your needs best. 

For Example 

You may prefer to see: 

van101 [jsmith] 
 

or 
jsmith [van101] 

 

If the asset type or POI type name is in bold face type, items of that type are viewable on the 
map. If the asset type or POI type name is in regular face type, items of that type are being 
hidden from the map. 

By default, offline assets (those not transmitting snapshots) are listed under their asset type, 

the same as assets that are online (transmitting snapshots). If you prefer, you can have all 
offline assets, regardless of type, appear in the tree under the "Offline" group. To do this, click 

in the top right portion of the screen to open the map options and check Group Offline 
Assets Together. 

 

Working with the Tree 

Nodes on the tree can be expanded (click the ) or collapsed (click the ). 

Selecting an item in the Map Items panel focuses the map around that item or, if icon 

clustering is enabled, around its cluster. 

Features available in the Tracking screen vary depending on whether you have selected an 

asset/POI type or a specific asset/POI. 
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Meaning of Asset Icons and Colours 

Assets are shown with the icon representing the Fleet product your organization subscribed to 
for the asset: 

 

• assets with the In-Vehicle Tracking product use the icon 

• assets with the Asset Tag/LBS Tracking product use the icon 

• assets with the Resource Tracking product use the icon 

The colour of the asset's icon indicates the status of the asset. 

Note: These icons and colours also appear on the asset grid. 
 

This icon... Means... 
 

red Asset is off-line or out of cell range, or its in-vehicle device is yet to be 
installed. 

 

red The LBS asset is not being tracked at the moment. 

red No transmission is being received from the handheld. 

green There is ongoing communication with the in-vehicle device and the 
vehicle is in motion. 

 

green The asset has a good GPS signal. 

 

green The LBS asset is in a location that is within the high range (less than 
500 metres). 

 

green and 
speedometer 

 
 

green and two 

pipes  

 

The asset with an in-vehicle device is travelling over the posted speed 
limit. 
 
 
The asset with an in-vehicle device is idle. 

blue The asset's ignition has been off for no more than 12 minutes. 

yellow There is ongoing communication with the in-vehicle device but the 
device’s GPS is not valid. 

 

yellow The LBS asset is in a location that is within the medium range (500 - 
5000 metres). 

black The asset has had its ignition off for more than 12 minutes. 

black The handheld asset has been still for at least 20 minutes. 
 

exclamation 

mark 

 

The handheld asset's GPS is restricted (such assets are not affected by 
the Group Offline Assets Together feature). 

 

A red bar behind an asset's description and icon indicates an alarm state: if you find alarm 

states are being triggered frequently, consult Fleet Complete technical support. 
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About the Map Items Panel: Detail 

The bottom portion of the Map Items panel of the Tracking Screen consists of multiple panes. 

The General pane shows general information about the currently selected asset or POI. 

For an asset, the General pane shows: 

• description 

• current speed 

• current direction 

• time of last snapshot 

• current address 

• current POI, if any 

• current LSD, if any 

• vehicle type 

• for an LBS device, the label associated with the signal accuracy 

For a POI, the General pane shows: 

• description 

• address 

Other panes show: 

• on the Custom Fields pane, the values for any custom fields configured for the 
currently selected asset or POI 

• if the asset is associated with a resource, on the Assigned Resource Custom Fields 
pane, the custom fields, if any, for that resource g 

• if the asset is associated with a crew, on the Members tab, the list of crew members 

• on the Sensors pane, the value of each of the currently selected asset's sensors 

• on the Events pane, any events for the currently selected asset 

Use the scroll bar to the right of the details area to scroll through all the available panes of 
information. 

 

About Map Options 
 

Use the map options of the Tracking Screen (click in the top right portion of the screen) to: 

• group offline assets together 

• follow the selected asset 

• allow icon clustering 

• show/hide traffic information 

• use direction icons for assets 

• set unit of measurement for maps 

• display asset or resource name first in the Map Items tree 

 

Working with Tracking 
 

Activating/Deactivating Output 

If a device has an associated output, you can activate or deactivate that output from the 

Tracking screen. You can choose to pulse or activate the output. 

"Pulse" is used to turn the output on and off rapidly. 

For Example A vehicle has a special sensor that unlocks the door. A driver has locked himself 
or herself out of the vehicle. Activating the output as a pulse sends three frequencies for 1.5 
seconds and unlocks the door for the driver. 

"Activate" is used to turn the output on. 

For Example A vehicle has a buzzer you use to check in with a driver to indicate they should 

call the office. You activate the output when the driver is working alone late at night, so you 
can be reassured about the driver's safety. 
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The function toggles between activating and deactivating the output. 

1.  Right-click on the asset in the map or Map Items tree and choose 

Activate/Deactivate Output or click . 

2.  Choose from the available outputs and choose whether you want to Pulse or Activate 
the output. 

3.  The output is sent based on the time of the device data settings for the asset: it is not 
sent immediately. 

4.  If you chose to activate, once the asset receives the output and responds, the button 
changes from Activate to Deactivate. To deactivate the output, click Deactivate. 

 

Adding a POI from the Tracking Screen 
From the Tracking screen: 

1.  Right-click on any location in the map or any asset in the Map Items tree. 

2.  Choose Add POI Here. 

3.  Complete the POI configuration. 
 

Assigning Resource/Crew or Run to Asset 

You can quickly assign a resource or run to the asset if necessary. The asset's current 

resource and run are shown in square brackets after the item's name in the Map Items tree. 

1.  On the Tracking screen, right-click on an asset in the map or Map Items tree and 
choose Assign Run or Assign Resource/Crew. 
- or - 

Select the asset in the map or Map Items tree and click  (assign run) or   (assign 
resource). 

2.  You are prompted to choose from the list of configured runs or resources. 
 

Changing Asset or POI Configuration from the Tracking Screen 
From the Tracking screen, to edit the configuration for any asset or POI: 

1.  Right-click on the item on the map or in the Map Items tree. 
 

2.  Choose Edit the Asset or click . 

To edit any asset or POI type: 

1.  Right-click on the type in the Map Items tree. 
 

2.  Choose Edit the Asset or click . 

See Changing Asset Configuration. 
 

Controlling Map Contents and Appearance 

Note that these features may affect maps used throughout Fleet Complete, not just those on 

the Tracking screen map. 
 

Showing or Hiding Items 

By default, all configured assets and POIs appear on the Tracking screen map. To speed up 
the time of map loading, and to help focus only on those items you want to track, you can 
choose to hide assets and/or POIs of a particular type. 

For Example You might have configured POIs for reporting purposes only. Since information 

about those POIs is not significant for tracking purposes, you hide them from the map. 

Right-click on an asset or POI type in the Map Items panel and choose Hide From Map or 
Show On Map. 

- or - 

Click on a type and click   (hide) or  (show). 

Items of the selected type will appear or disappear on the map (hidden types are shown in the 

Map Items tree in regular font, revealed ones are shown in bold). Even though items are 
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hidden, their information remains in the Map Items tree, and alerts continue to be received 

from assets of the hidden type. 
 

Showing Items as a Cluster 

If individual icons are too close together to be seen as distinct entities on the map, you can 
choose to show a cluster icon instead. Clustering reduces icon clutter when mapping many 
items that are in close proximity. It also speeds up map rendering because there are fewer 
icons to display. 

 

Click in the top right portion of the screen to open the map options, and check Allow Icon 
Clustering. 

Illustration Of Icon Clustering 
 

 
 

When the mouse pointer is hovered over a cluster, a clickable list of icons and POIs in the 

cluster appears in a caption box. 

Example of Caption for Clustered Items 

 
 

Note: At the maximum zoom level, icons are never clustered. 
 

Displaying Direction Arrows or Icons 

By default, assets are shown on the Tracking screen map with the icon associated with their 
asset type. If you wish, you can instead have assets show arrows indicating the direction the 

asset is travelling. Click in the top right portion of the screen to open the map options, and 
check Use Direction Icons for Assets On Map. A legend explaining the different icons and 

colours also appears. 

Note: The same icon is shown in the map items panel. 
 

Temporarily Overriding Asset or POI Type Icon 

To temporarily change the icon used to represent assets or POIs of a particular type, right- 
click on the type name in the Map Items tree and choose Override Icon. Choose from a list 

of possible icons, then click Set. To restore to the original icon, click Restore. 
 

Displaying Place Details 
If you wish, you can display detailed information, including address, latitude, and longitude, 
about any position on the Tracking screen map. 

For Example You want to quickly identify the address at the intersection where an asset has 
stopped. 

1.  On the Tracking screen map, right-click on any location and choose Get Place Info. 

2.  Details about the position appear in a pop-up window. 
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Focusing the Map Display 

To focus the Tracking screen map on a specific asset or POI, click on the item in the Map 

Items tree. The current map zoom level is retained: to zoom in on the item, right-click on the 

item in the Map Items tree and choose Zoom To or click . 

To zoom the map so it shows all the items in an asset or POI type, right-click on the type in 

the Map Items tree and choose Zoom To or click . 
 

As assets move, they may disappear from the map. To avoid this, click in the top right 
portion of the screen to open the map options and check Follow Selected Asset. This 
ensures the map remains focused around the selected asset or assets of the selected type, 
regardless of where they move. 

To focus the map on a specific address, enter the address (including street, city, and 
province/state) in the right-hand field above the map and press Enter. 
If more than one address matches your entry, a list appears, from which you select the 

correct address. The address is marked with a yellow circle on the map. This marking remains 

only until you exit Fleet Complete, or until you enter a new address. To remove the mark, click 
the x beside the address field. 

 
 

Following an Asset in a New Window 
If you want to monitor several assets simultaneously, you can follow each in a new map 

window, keeping the main map available for monitoring multiple assets. 

1.  On the Tracking screen, right-click on an asset in the map or Map Items tree and 
choose Follow in New Window. 
- or - 

Select the asset in the map or Map Items tree and click . 

2.  A new window appears, focused around the selected asset and offering the usual map 

controls. 

3.  To close a window, click the . 

 
Note: You can open as many windows as you need and move them independently to new 
locations on your workspace. 

 

Locating Closest Assets 

It can sometimes be useful to find out if any assets are near a specific location on the map. 

For Example You want to see which assets, if any, are near the location where a pickup is 

waiting. 
A vehicle is disabled and you want to find out which assets are near that vehicle at the 
moment, so they can provide assistance or transfer the cargo. 

A customer wants to know how far away an asset is from their office, so they can anticipate 
how long until that asset arrives. 

To locate the closest assets to any location, asset, or POI: 

1.  On the Tracking screen, right-click on the item in the map or, for assets and POIs, on 
the Map Items tree. 

 

2.  Choose Locate Closest Assets or click . 

3.  A list of the closest assets, including their driving distance from the selected location, 
appears. 

4.  Double-click on any asset to focus the map around it. 

Note: Fleet Complete defines "closest" as an asset that was within 50 km/31 miles of the 
selected location, asset, or POI any time within the past 48 hours. 
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Printing the Map 

To print the current map view, from the Tracking screen, click    (in the top right corner 
of the screen). 

 

Replaying a Trip (Trip Replay) 

Use this function to identify issues that might be involved in a specific trip. To explore the 
issues in more detail, or to make comparisons (for example, comparing one day's trip with 

another), use the Reports function instead. Note that any alerts triggered during the original 
trip are not shown in the replay. 

Note: This function is available only for assets with in-vehicle devices that have valid ignition 
sensors. The Breadcrumb Trail offers a similar feature for other assets. 

1.  On the Tracking screen, right-click on an asset in the map or Map Items tree and 
choose Trip Replay. 
- or - 

Select the asset and click . 
The Trip Replay screen opens. 

 
 

2.  By default, the trip replay shows the most recent trips for the current day's work 
schedule. If necessary, choose a Start Date and End Date for the trip you want to 

replay and click Load Trips. 

3.  To play all the listed trips, click . 
- or - 

Click the trip you want to replay. 

shows the path followed by the asset. Any events triggered during the trip are 

labelled on the map and appear when you hover over the  in the Positions list. The 

map offers the usual map controls and a legend explaining the different icons and 
colours. 

4.  The Trips list shows a summary of each trip in the replay period, including it start 

time, timezone, distance travelled and length of trip. Trips are sorted based on UTZ. 
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The Positions list shows the details of each snapshot. To highlight a specific position in 

the map, click on it: its positional arrow becomes yellow. To see the time the asset 
was at any marked position on the map, hover over it. 

5.  If desired, show custom layers and/or POIs in the trip replay map by clicking Options 

and choosing the appropriate option(s). 

To move through the trip, click the appropriate option to start (  ), (pause ( ), go to the 

next position ( ), or go to the previous position ( ). The progress of the asset on the trip is 

shown by a blue dot at the currently selected position. 

To increase or decrease the speed of the replay, drag the slider. 

 
 

Note: You can re-size the Trip Replay screen if necessary. 
 

Requesting Current Position of Asset 
Caution: This function requires communication with the asset. Depending on your service plan, 
this may lead to additional service charges. Access to this function should be restricted. 

At times it can be useful to immediately update the display of an asset to show its current 

position, without waiting for the next snapshot. 

1.  On the Tracking screen, right-click on an asset in the map or Map Items panel and 
choose Get Position. 

2.  A confirmation message appears. 
 

Setting Unit of Measurement for Maps 

You can set the unit of measurement used on the map. This setting does not affect other 

users, and is retained when you log off. Your choice will be in effect everywhere that a map 
appears in Fleet Complete. 

 

Click in the top right portion of the screen to open the map options and click either Metric 
or Imperial. 

 

Showing Additional Map Information 
 

Using Custom Layers 

If you have access to custom layers, you can use them as an overlay on the Tracking screen 
map. Business rules that are associated with custom layers are not used in Fleet Complete. 

The following types of custom layers are supported: 

• Bing Collection (a shared collection from Microsoft Live) 

• GeoRSS 

• KML 

• Tile 

To add a custom layer: 

1.  Click Custom Layers (top right part of the Tracking screen). 

2.  Click Add and choose the type of custom layer to add. 

3.  Enter a Description (name) for the custom layer. 

4.  Enter the necessary identifying information for the custom layer type. 

5.  Click Accept & Close. 

To display a custom layer, right-click on its name in the Map Items panel of the Tracking 

screen and choose Show on Map. You can hide a layer again by right-clicking and choose 
Hide on Map. 

Note: For LSD users, LSD information is presented on a custom layer provided with your 
configuration. 
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Showing/Hiding Labels 

Assets are identified on the map by their type icon and POIs by their type colour. If you need 

to see more details, you can display labels (names) adjacent to each item. To do this, right- 

click on a type in the Map Items tree and choose Show Labels or click . To hide them 

again, right-click and choose Hide Labels or click . 
 

Showing Traffic Information 

This function is useful for directing assets to more efficient routes, if the planned route seems 
congested. 

 

Click in the top right portion of the screen to open the map options, then check Show 
Traffic Information. 

A legend explaining the colour-coding appears in the top right corner of the map, and all roads 

are colour-coded to indicate the amount of traffic on that road at the current time. This 
information is updated instantly. 

Note: It may be necessary to zoom the map out to display traffic information. 
 

Using Departure Notification 

At times it is useful simply to know when an asset starts to move beyond a certain point, even 
if that asset is offline. The departure notification function places a circle around the asset on 
the Tracking screen map. When the asset moves beyond that radius, you receive an e-mail 

message. 

1.  Set the departure notification radius in system options. 

2.  On the Tracking screen, right-click on an asset in the map or Map Items panel and 

choose Departure Notification, or select the asset and click . 

3.  A circle of the appropriate radius surrounds the asset, and the map focuses on the 
asset. 

4.  Once the asset moves outside the circle, an e-mail message is sent to you, indicating 
the name of the asset and the time it moved. The circle on the map disappears. The 

departure notification will not appear again unless you repeat the process. 

To cancel departure notification, repeat step 1. 
 

Viewing An Asset's Activity 
Use this function to get a quick view of the activity, in the current or previous work schedule 

hours, of an asset with an in-vehicle device. The meaning of "previous" depends on your work 
schedule configuration and the day on which you use this function. 

For Example If an asset's work schedule does not include weekends, looking at the previous 
activity on a Monday will show the data gathered during Friday's work schedule. 

If the asset's work schedule starts at 8 am and the driver starts the vehicle at 7:45 am and 
turns it off at 7:59 am, no "ignition on" or "ignition off" activity will be seen because the 
activity happened outside the work schedule. 

Only activities that started or ended within the work schedule appear. 

For Example If the asset's ignition was turned on before the work schedule began, the Asset 

Activity screen could show an "ignition off" but not the previous "ignition on". 

1.  On the Tracking screen, right-click on an asset in the map or Map Items tree and 

choose Asset Activity. 
- or - 

Select the asset and click . 
The Asset Activity screen opens. 
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Note: You can have several Asset Activity screens open at the same time. 

2.  To show the previous work schedule day, choose Previous from the Activity Period 
list. 

3.  By default, activities are shown as a list of names, without indicating the location at 
which the activity occurred. To show the location for each activity, check Show 
Locations. The location for each activity appears below the activity name. 

Note: Information in the Asset Activity screen continues to refresh as long as the screen 
remains open. 

Activity information includes information about the asset — the name of its work schedule, 
device data settings, associated resource, and so on. 

The Activity Summary area shows a summary of the activities for the asset: 

• the start/end time of its work schedule 

• the time of first ignition on, last ignition off, and first movement 

• the total number of stops the asset made and the total number of those that were not 
within a POI 

• the length of time the asset was stopped but not in a POI 

• the total number of trips the asset made 

• the total distance the asset travelled 

• the total number of POIs the asset visited 

• the fuel economy of the asset (if the vehicle has an ECM device) 

• the number of DTC codes triggered by the asset (if the vehicle has an ECM device) 

The time, duration, and (optionally) location of each activity is listed. 

Pie charts show: 

• the relative proportions of time the asset was travelling at specific speed ranges (this 

is intended not to track driver behaviour, but to monitor fuel consumption by 
identifying asset speeds that are known to affect fuel consumption) 

• the relative proportions of time the asset was idle, moving, or stopped 

• the relative proportion of specific rules triggered by the asset 

Note: To see activity details for a longer timeline, or outside of the asset's work schedule, use 

the Activity report. 
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Viewing Breadcrumb Trail for a Trip 

Use this function to view the details (such as speed-related information, asset's position, 

readings from sensors, and odometer readings) of each snapshot taken during a specific time 
period. 

This feature is available for assets that have ignition sensors. For assets with in-vehicle 

devices, the snapshot on the map will show the direction the vehicle was travelling at the time 
of the snapshot. For assets with hand-held devices, the snapshot will show a solid circle on the 
map where the snapshot took place. 

1.  On the Tracking screen, right-click on an asset in the map or Map Items tree and 
choose Breadcrumb Trail. 

- or 

Select the asset and click . 

The Breadcrumb Trail screen opens. 
 

 
 

2.  Use the top portion of the screen to view details of each position of the asset (as in the 
Position report). Click on a row to centre the map around that position. 

3.  By default, the Breadcrumb Trail shows the past 24 hours of data (the Start Date 

defaults to 24 hours before the time the screen was opened): to change the data 
shown, change the Start Date and/or number of Hours and click Load Breadcrumb. 

4.  Click on an item in the map to display details about it, including sensor readings at 

that point. 

Note: For assets with in-vehicle devices, a legend explaining the icons and colour-coding 

appears on the map portion of the screen. 

Note: If you print the breadcrumb trail, the report will show all entries in the grid and the map 
as currently displayed on the screen. 
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Viewing Events 

If a rule has been triggered, the relevant event information is shown in various parts of the 

Tracking screen: 

• in the Map Items details area, when you select that asset 

• in the pop-up details that appear when you hover the cursor over an asset on the 
main map or on the map shown when you follow the asset in a new window 

• in the Asset Activity displayed for the asset (shows the number of times the rule was 
triggered, but not the details of the event) 

• in the Trip Replay for an asset 

Note: If the rule was configured to result in an alert, an alert also appears. 
 

Working with Map Controls 
A map appears in numerous configuration screens in Fleet Complete. Wherever the map 
appears, it offers the following controls: 

• to pan, click on the map and drag it until the desired section is shown, or use the pan 

control 

 
 

• to zoom in or out, use the zoom controls 

 
 

• to change the map view, use the view controls 

 



Fleet Complete User Guide 18 

Common Configuration Functions Adding Notes  

 

 
 

 

COMMON CONFIGURATION FUNCTIONS 
 

Adding Notes 
A Notes tab appears on the activity properties screen. 

To add a note: 

1.  On the Notes tab, click . 

2.  Choose a note type (see below). 

3.  Enter the text of your note and click Save & Close. 

Notes types for activities include: 

• internal only — notes that can be viewed only within your organization 

• external — notes that can be viewed outside your organization 

• resource — notes that can be viewed only by the resource to whom the activity is 
assigned 

 

Adding Placeholders 
Many configuration tasks in Fleet Complete require you to choose from a drop-down list (for 

example, an asset needs to be assigned an asset type). If the list does not contain the 
element you want, you can add a placeholder. The element you add this way is not fully 
configured: you will need to modify it to define it further. 

To add a placeholder: 

1.  On a configuration screen (such as the asset configuration screen), look for drop-down 
lists with a + beside them and click the +. 

2.  A truncated version of the configuration screen for that element (for example, the 
asset type screen) appears. 

3.  Enter the necessary information (typically, at least the element's name) and click 

Accept & Close in that screen. 

Important: The element you have added has not been saved at this point. It will only 

be saved if it is shown in the relevant field when you click Save & Close on the screen 
from which you clicked the +. 

4.  If necessary, re-display the element's configuration screen by clicking the ellipsis (...) 

and revise your entry. 

5.  Continue with data entry on the original screen and click Save & Close. Both the data 
you entered, and the new element shown in the placeholder field, are saved. 

6.  Be sure to navigate to the appropriate area in Fleet Complete (for example, asset type 

configuration) and complete the configuration of the element you added. 
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Customizing Data Collection Using Custom Fields 
 

Why Use This Function? 
If additional information is required that cannot be accommodated in the predefined fields for 

assets, POIs, and/or resources, you can create custom fields to hold that information. 
Information stored in custom fields may appear on the Tracking screen (in the Custom Fields 
area), in e-mail notifications, and in reports. 

You can use custom fields to hold any information you want to gather and/or display to users. 
For example, you might want to use custom fields to: 

• display a picture of a POI 

• record the qualifications of a resource (such as ability to cross a border, whether or 
not certified to handle hazardous materials) 

• record descriptive information (such as colour or distinguishing markings) about an 
asset 

We Recommend Before you choose to use custom fields, become aware of the data that is 

normally collected by Fleet Complete so you can identify which additional data you want to 
collect. 
If you decide you need custom fields, it saves time if you set them up before doing extensive 
data entry or allowing users access to Fleet Complete, so that all the necessary information is 

collected at the same time. 
 

What is the Default Configuration? 
No custom fields are configured by default. 

 

What Do I Need to Understand About Custom Fields? 

Custom fields apply only to a specific item: for example, the custom field defined for an asset 

cannot be used for a resource. . 

We Recommend Once you configure your custom fields, test them thoroughly before adding 

other users to your system. Although custom fields can be added at any time, it is best to add 
them before much data entry is done. 

Custom fields are available for assets, POIs, and resources. 
 

How Do I Configure Custom Fields? 
To configure custom fields: 

1.  On the resources, assets, or POI grid, click Custom Fields. 
A list of the currently configured custom fields for that entity appears. 

2.  Click Add and choose the type of custom field. 

A new screen opens. 

3.  Enter the appropriate values. The contents of the screen vary depending on the type 
of field chosen. 

 

If you want to capture... Use this type of custom field... 
 

true/false (yes/no) value Boolean 
 

a date Date (can default to current day) 
 

a time Time (can default to specific time) 
 

a date and time Date/Time (can default to specific time on current 
day) 

 

an image Image 
 

one value from a list of List 
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If you want to capture... Use this type of custom field... 

items 
 

a monetary value Money 
 

a numeric value Numeric 
 

text Text 
 

4.  Enter the Field Label to be displayed to the user. 

5.  If custom actions (used to retrieve information from a web service) have been set up 

for you by Complete Innovations, choose the Custom Action for the field. 

6.  Where applicable, choose the visibility of the field. You can specify that the field's 
values appear in one or all of the following: 

• the Map Items panel of the Tracking screen, which shows details of the 
selected asset 

• the map itself, as part of the asset's label 

• e-mail notifications that result from an event being triggered 

• reports 

7.  Enter or specify the field's default value, if relevant. 

8.  For a List type of field, add at least two items and set their order. 

For a Text type of field, enter a mask. 

The order in which the fields appear on the Custom Fields screen is the order in which they will 

appear on data entry screens. Click the up and down arrow buttons to change the order of 
fields. 

Important: Deleting a custom field also permanently deletes any data associated with that 
field. 

 

Deleting Data 
This help file explains only "add" functions. To delete data, simply select it in the appropriate 

grid and click Delete. If your deletion could affect data integrity (for example, you attempt to 
delete an item that is used in a rule), you are warned of this and may not be able to proceed. 

 

Specifying Addresses 
In many Fleet Complete screens, you need to specify an address (for example, the address of 
a POI). In most cases, the screen on which you specify the address offers two ways to enter 
it: by entering the address information in fields, or by using the map that appears on that 
screen. 

 

Specifying Address by Entering Data in Fields 
Note: Do not use this feature for POIs where you want to specify the POI as a line or area 
rather than a circle. 

Enter address details in the provided fields (Street, City, Postal/Zip Code, State/Province, and 
 

Country). As soon as you have entered enough defining information, a pin appears on the 

map, indicating the address location. (To remove the pin and re-specify the address, click 
Erase.) Change the Buffer size (field below the map). When you save the record, a circle of 
that size is drawn around the address. 
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Specifying Address Using the Map (Circle) 

1.  Use the map controls to navigate the map to show the area containing the address. 

2.  If desired, change the Buffer diameter. 

3.  Click Circle, then double-click on the map to indicate the centre of the address 
location. 

 

A surrounded by a circle the size of the buffer is drawn and the address fields are 
populated. 

 

Specifying Address Using the Map (Line) 

1.  Use the map controls to navigate the map to show the area containing the address. 

2.  If desired, change the Buffer diameter. 

3.  Click Line. 

4.  Click on the map to set the starting point. 

5.  Drag the mouse pointer to draw the line (clicking at each change in direction) 

6.  At the end point, double-click to finish the line. 
A line the buffer's width is drawn, with boxes at each point where you changed 
direction. 

Show Screen 

The address of the end point of the line appears in the address fields 

 
 

Specifying Address Using the Map (Area) 

1.  Use the map controls to navigate the map to show the area containing the location. 

2.  Click Area. 

3.  Click and drag on the map to draw the first line. 

4.  Continue clicking and drawing additional lines to represent the area. 

5.  When you have completed the area, return to the starting point and click twice to 

complete the area. 
An area is drawn, with boxes at each point where you changed direction. 
The address in the middle of the drawn area appears in the address fields. 

 

Modifying Address on Map 
You can change the Buffer diameter after specifying the address. 

To change the parameters of a line or area, click the  on the line and drag it to a new 
location. 

To remove the address selection from the map, click Erase and use the map to specify the 

address again. You will need to manually enter the address information in the fields. 

Note: Changes to the address fields do not apply to the map version of the address, and 
changes to the map do not change the address fields. The address shown on the map is the 
one that Fleet Complete considers valid. 

 

Entering Data 
When entering data in Fleet Complete, be aware of the following data entry conventions: 

• a red asterisk beside a field's name indicates a required field 

• a + beside a drop-down list indicates you can add a placeholder 

To clear an entry selected from a list, click the x to the right of the arrow. 
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Entering E-mail Addresses 

In fields where you enter e-mail addresses, you can enter multiple addresses, separated by 
semicolons or commas. 

 

Entering Hours 
Several configuration functions in Fleet Complete require you to specify a schedule of days and 
hours (for example, an asset's work schedule or a POI's working hours). 

Where this function is available, follow these steps: 

1.  In the hours display, be sure that only those days you want included in the schedule 
are checked. 

2.  For each checked day, click the Window column and choose whether you will be 

defining the hours in that day's 24 hour period as Between or Outside Of the 
specified times. 

3.  Enter or choose a Start and End time for the day. 

 

Modifying Data 
This help file explains only "add" functions. To modify existing data, select the item in the grid 
and click Edit, or double-click on it. 

 

Working with Multiple Languages 
Fleet Complete supports multiple languages for the interface itself, the alerts it displays, and 

the e-mails it sends. A user's account specifies their preferred language, but you can choose a 
different language at login time. The selected language is saved as part of the user's account. 

Whenever you configure e-mail communication with someone who is not a Fleet Complete 

user (such as a specific contact, you can specify the language to be used for e-mail messages 
sent to them. 

 

Working with Masks 
Masks are used in custom fields. Fleet Complete follows Microsoft conventions for mask 
definitions. 

For example, the mask for an Ontario driver's license would be L0000-00000-00000; the mask 
for a phone number would be 000-000-0000. 
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BRANCHES 
 

About Branches 
Note: The branch feature is optional. To activate the feature, add a branch to the root 

(company) branch, log off, and log on again. 
 

Why Use This Function? 

Use this function if you want to control access to data entities (assets, resources, etc.) based 
on the data's relevance to a specific part of your organization's hierarchy, most typically a 
geographic one. Each element in the hierarchy is called a "branch". You can have as many or 

as few branches and levels as suits your needs. 

Example Hierarchy 

 
 

What is the Default Configuration? 

By default, Fleet Complete provides a root (company) branch that applies to all users and 

data. To use the branch feature, you need to create a hierarchy of additional branches and 
then associate existing data to the appropriate branch. As you add data to Fleet Complete, 
you will be prompted (where necessary) to choose the branch to which the data belongs. 

Note: An entity's branch is shown in the bottom right corner of its properties screen. 
 

What Do I Need to Understand About Branches? 

Branches exist at different levels in a hierarchy: you can name those levels, or the system will 
automatically assign them a numeric name. For example, the system uses "Level 1", "Level 

2", "Level 3", and "Level 4" but you could replace those with more meaningful names, such as 
"company", "region", "district", and "terminal". Level names are just labels: they do not 
appear to other users and have no functional significance. 

For most (but not all) entities assigned to branches, you choose whether that entity should be 
available only within its branch or also available in all that branch's sub-branches ("shared"). 

Some entities exist independent of branches: all types (asset types, POI types, vehicle types, 

etc.), MDT messaging, custom fields, runs, and types of maintenance services (but not 
maintenance data itself). 

Careful planning is required to ensure that all entities are assigned to the appropriate branch. 

For the most part, entities are associated with branches at creation, so it is easier to get 
associations correct from the start rather than attempt to adjust them later. Give careful 
thought to the impact of allowing sub-branches access to branch-specific data — this provides 
more flexibility, but somewhat less control. 

Holidays for the entire hierarchy are added at the root branch level. Whether a branch is open 

(the default) or closed on any configured holiday depends on the configuration of the branch 
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itself. You will need to add, in the root branch, holidays for any day where at least one branch 

is closed. 
 

What Do I Need to Understand About Branch Configuration? 

Branches can be either administrative (do not have a physical location) or physical (have a 
physical location). In all other ways, the two types of branches are identical: you choose the 
type of branch when you create it. 

Note: Only physical branches can act as the home base for an asset or a resource. A branch's 
type cannot be modified once the branch is created. 

Branch configuration includes defining: 

• which user should be the branch manager (receives alerts and notifications related to 
the branch — for future implementation) 

• working hours for the branch 

• optionally, different system defaults than those in the branch above 

• users who are branch administrators (for future implementation) 

• which of the custom fields set up in Fleet Complete should be hidden in this branch — 

for example, you might want to capture the ability of an asset to cross the border only 
for those branches that deal with cross-border travel 

• whether the branch is open or closed on specific holidays (you are warned, but not 
prevented from proceeding, if you book an activity for a holiday) 

Except for system defaults, all other configuration settings apply only to the current branch, 
not any sub-branches that might exist or be created. 

For more guidance on setting up branching, see the Branch Planning Guidelines PDF. 
 

Opening the Branches Grid 

1.  On the ribbon toolbar or main menu, click System > Administration > Branches. 

2.  The Branches screen opens, showing a grid of existing branches, displayed in a tree 
hierarchy which can be expanded and collapsed. The description and branch level of 
each branch is shown. 

 

Setting up Your Company 

To set up your company: 

1.  On the Branches grid, double-click on your company name. 

The Branch screen opens. 
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2.  On the General tab, enter a Description (name) and a unique identifying Code (used 

for reporting purposes). 

3.  Choose the user who will be the Manager of the company within Fleet Complete (for 
future implementation). 

4.  Specify the Working Hours of the company. 

5.  Set the system defaults. 

6.  Enter the address for the company. 

7.  On the Users tab, check the user who should be a company administrator (for future 
implementation) . 

8.  On the Exclusions tab, you see three sub-tabs listing the custom fields defined in Fleet 
Complete for different entities. This tab is not applicable to environments that do not 
use the branch feature. 

9.  On the Holidays tab, set up holidays that may result in company closure. 

a.  Click Add. 
The Holiday screen opens 

 

b.  Enter a Name for the holiday and the dates on which the holiday occurs. Holidays 

are static so, for holidays that change from year to year, you will need to enter 
year-specific holidays (for example, Labour Day 2012, Labour Day 2013). 

c. Choose whether your  company is open or closed on the holiday. 

d.  Click Save & Close. 

Note: If you attempt to create activities for holidays on which your company is closed, 
you will be warned of this. 

10. Click Save & Close. 

You can also use this screen to see which users have made changes to this information and 
what those changes were (Audit tab). 



Fleet Complete User Guide 26 

Common Usage Functions Changing Your Password  

 

 

 
 
 

COMMON USAGE FUNCTIONS 
 

Changing Your Password 
For security purposes, you should change your password at regular intervals. 

To change your password: 

1.  From the main menu, click Change Password. 

The Change Password screen opens. 

2.  Enter your old password and a new password (made up of at least six alphanumeric 
characters). 

3.  Confirm your new password. 

4.  Click Save & Close. 

 

Customizing the Appearance of Your Interface 
These functions apply only to your user account, and do not affect other users. 

 

Controlling Contents of the Quick Access Toolbar 
It can be useful to hide functions that are not available to your user account: to do this, right- 
click on an item and choose Remove from Quick Access Toolbar. 

You can customize the quick access toolbar to show the functions you use most often. To add 

an item to the quick access toolbar, right-click on any item in the main menu or the ribbon 
toolbar and choose Add to Quick Access Toolbar. 

For Example If you have access only to the Tracking or Maintenance functions, add those 

functions to the Quick Access Toolbar, then minimize the ribbon and use that toolbar as your 
main navigation tool. 

 

Choosing a Colour Scheme 
You can choose a colour scheme for the Fleet Complete interface that reflects your personal 
preferences. 

 

Click , then choose from the available themes. 
- or - 

From the main menu, click Preferences > Themes and select a theme. 
 

Showing or Hiding the Ribbon Toolbar 
You can hide the ribbon toolbar, allowing more room on your display for data screens. 

 

Click , then check or clear Toolbar. 
- or - 

From the main menu, click Preferences > Toolbar. 
 

Rearranging Order of Toolbars 
To move the quick access toolbar to below the ribbon toolbar, right-click on any item in the 

main menu or the ribbon toolbar and choose Show Quick Access Toolbar Above Ribbon. 
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Printing/Exporting Data 
Most grids in Fleet Complete provide a print/export function you can use to print and/or export 
the information shown in the grid. This is useful for troubleshooting, for more detailed analysis 
of data, or to allow you to export data from Fleet Complete for use in another system. 

Note: Since data is retained for a limited time, you may want to regularly export important 
data. 

To print or export data: 

1.  On any grid, click Print/Export. 

A Preview screen opens, showing the data as it will be printed or exported. 

2.  If you plan to print the data, you can add headers and footers, add background colour, 
and perform other formatting functions, then choose File > Print. 

- or - 

If you plan to export the data, choose File > Export Document or File > Send via 
e-mail and choose the appropriate export format. Choosing the e-mail option creates 

the export file and then automatically attaches it to an e-mail message in your default 

e-mail program. You are prompted for information that reflects the needs of the 
output format. 

The most common export formats are XLS (Microsoft 2003 Excel format) and XLSX (Microsoft 
2007 Excel format). These formats prompt for: 

• the name to give the worksheet created by the export process 

• whether you want to export data or text (exporting data means the data's format, not 
just the data itself, will be exported) 
For Example If the grid includes a date, exporting text means the date will appear as 

a text string in Excel; exporting it as data means it will appear in a date format cell in 
Excel. 

• whether you want gridlines to show 

Note: The hyperlink feature is reserved for future use. 

 

Recovering a Lost Password 
If you have forgotten your password, on the login screen click Forgot Password? Click here. 
You will receive an e-mail message with instructions on how to recover the password. This 
message also includes your client number. 

 

Viewing Events 
If a rule has been triggered, the relevant event information is shown in various parts of the 

Tracking screen: 

• in the Map Items details area, when you select that asset 

• in the pop-up details that appear when you hover the cursor over an asset on the 
main map or on the map shown when you follow the asset in a new window 

• in the Asset Activity displayed for the asset (shows the number of times the rule was 
triggered, but not the details of the event) 

• in the Trip Replay for an asset 

Note: If the rule was configured to result in an alert, an alert also appears. 

 

Viewing History of Configuration Changes 
Virtually all data entry screens in Fleet Complete include an Audit tab. This tab shows which 
user made changes to a specific item (such as an asset type) and what those changes were. 

To see the details of changes made by a specific user across the whole system, use the Audit 

Trail. 
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Viewing History of Status Changes 

Maintenance items show a History tab that records the progress of a maintenance item or 
task, for example, its change in status over time. 

 

Working with Alerts 
Note: You only see alerts if your user account is set up to show them. 

Alerts appear in: 

• pop-up messages 

• the Alerts panel (where they remain until you clear them, or until you close your 
session and log off) 

In the Alerts panel you can click the  to roll up and  to expand a given alert. 

To clear all displayed alerts, click Clear Alerts. 

Note: Even when alerts are cleared, the alert data remains in your Fleet Complete system and 

is shown in reports. 

 

Working with Grids 
Fleet Complete configuration and report screens display data in a grid which you can 

customize to meet your information needs. 
 

Changing What Columns of Data are Displayed 

To remove a column, do one of the following: 

• drag the column into the grid until an "X" appears 

• right-click on a column header and choose Remove This Column 

• click Column Chooser and drag the column to the Customization screen that appears 

To add a column, right-click on a column header and choose Column Chooser, then in the 

Customization screen that appears, either double-click on the desired column to restore it to 

its original location, or drag the desired column to the appropriate location in the grid. 
 

Changing How Data is Displayed 

To change the sort order of data, click on a column heading (toggles between sorting in 
ascending and descending order), or right-click on the column heading and choose Sort 

Ascending or Sort Descending. 

To change the order in which columns are presented, click a column heading and drag the 
column to the desired location. 

To resize a column so that more columns can be shown, do one of the following: 

• drag the dividing line between columns 

• right-click on the column heading and choose Best Fit to resize just the selected 
column 

• right-click on the column heading and choose Best Fit (all columns) to resize all the 
columns in the grid. 

To group information, giving a more compressed view of the data, right-click on a column 
heading and choose Group By This Column and then do one of the following: 

• drag the desired column to the header area of the grid 

• right-click on the column heading and choose Group by This Column 

Data in the grid is compressed based on the "group by" column. 

For Example 

The rules grid shows rules of all types. When you drag the Rule Type column to the Group By 
heading, data is compressed by rule type: 
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To display the contents of a single group, click the "+" to the left of a group. To display the 
contents of all groups, right-click on the item in the Group By box and choose Full Expand. 

 

 
 
 
 
 
 
 
 
 
 
 

You can group by more than one column (this is particularly useful for reports and activities). 
For example, if the grid shows assets and asset types, you can group by asset type and then, 
within that type, by asset name. For more on this option, see Working with Report Output or 
Searching for Activities. 

 

Finding Data 

To filter the display so it shows only records that contain a specific string: 

1.  Right-click on a column heading and choose Show Find Panel. 

2.  In the panel that appears at the top of the grid, enter the string you want used for the 
search. 

3.  Click Find (if necessary: the grid filters as you type). 
The grid changes to show just data that contains the string, with the string 

highlighted. 

To show the full set of data again, click Clear. 
 

Filtering Data 

To filter the display so it shows only records that contain a specific value for a column, click 

the      beside a column name to display a list of possible values for the column, then 

choose one of the values. The grid changes to show only records with that value. 

For Example The rules grid shows rules of all types. When you filter the Rule Type column to 
show the value "Idle", only Idle rules are shown in the grid. 

Note: Not all columns can be filtered. 

The bottom of the grid shows a filter bar. Use this bar to clear the current filter (clear the 
checkbox or click the ). You can also clear the filter by right-clicking on the column heading 

and choosing Clear Filter. 
 
 

Note: A Filter Editor is available (right-click on a column heading and choose Filter Editor) for 
more advanced filtering. For help on using the editor, consult with Fleet Complete technical 
support. 
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Working with Panels 
Several screens in Fleet Complete offer information in several panels. 

When a panel is closed, it appears as a tab. 

 

To temporarily open a panel, hover the mouse pointer over the tab (the panel will close when 

you move the mouse pointer away). To keep the panel open, click the . 

To open the panel, click on the tab (the panel will remain open until you click outside it). 

To close a panel, click . 
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USERS AND SECURITY 
 

Background 
 

About Security Profiles 
 

Why Use this Function? 

Use this function to control which Fleet Complete functions users can perform. 
 

What is the Default Configuration? 

Fleet Complete ships with profiles that grant access to all functions: these profiles cannot be 
deleted or edited. You will want to create additional profiles that meet your user access needs 
and assign them to your user accounts. 

 

What Do I Need to Understand About Security Profiles? 

There are two types of security profiles: system profiles and security profiles. 

System profiles allow users to work with (add, edit, and/or delete) data that is not associated 
with the company (root) branch, as well as generate reports (all reports or only specific ones). 

Security profiles allow users to work with data associated with the company (root) branch, 

such as assets and resources. They also control access to administrative functions such as 
editing system options. Access can be limited to only specific asset types, allowing users to 
work with and receive alerts for only assets of specific types. 

For Security Profiles, We Recommend If you want to limit users to working with specific 

types (e.g. resource types), you should configure all the types for your organization before 
setting up users and security, to avoid having to return and add type restrictions later. 
Security functions affect all Fleet Complete users and should be restricted to few, if any, users. 
Functions associated with data costs, such as getting an asset's current position, sending a 
message to a resource, or activating an asset's output, should be restricted, to avoid 

unnecessary expense. 

Suggested Planning Plan security profiles that reflect your organization's specific needs. 

Keep in mind that some tracking information may have privacy issues, so you should consider 
restricting access to certain views and reports. Typically, security profiles are used to control 
access based on a user's geographical location, while system profiles are used to provide 
access to the type of Fleet Complete functions users need in order to do their jobs. 

 

About User Accounts 
 

Why Use this Function? 

Use this function to control who has access to your Fleet Complete system. User accounts 
control access only: the functions that users can perform in Fleet Complete are determined by 
their security profiles. 

 

What is the Default Configuration? 

Fleet Complete ships with a built-in Administrator user account associated with built-in 

security profiles that grant access to all functions. This user account cannot be deleted or 
edited. You will want to create additional users who will be granted their own, more limited, 

access to Fleet Complete. 
 

What Do I Need to Understand About User Accounts? 

A user account specifies the user's login name, e-mail address, desired language, and whether 
the user sees alerts and/or MDT messages. It does not include the user's password: when you 
create a user, a message is sent to the user's e-mail address with their login name, system- 
created password, and instructions on how to log in. At first login, the user is prompted to 

create a password. 
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Opening the Users Accounts Grid 

1.  On the ribbon toolbar or main menu, click System > Administration > Users 

Accounts. 

2.  The Users Accounts screen opens, showing a grid of existing user accounts and 
summary information about each one, including the time that user last logged in, and 
their security profiles. 

 

Opening the Security Profiles Grid 

1.  On the ribbon toolbar or main menu, click System > Administration > Security 

Profiles. 

2.  The Security Profiles screen appears, showing a grid of existing security profiles, the 

branch to which the security profile belongs (or "SYSTEM" for system profiles), and 
whether or not the security profile is a system profile. 

 

Setting up Users and Security 
 

Setting up Security Profiles 
Note: Be sure you are familiar with the overall concepts of security profiles before proceeding. 

To set up a security profile: 

1.  On the Security Profiles grid, click Add Profile. 
- or 
On the Security Profiles grid, click Add System Profile. 
The Security Profiles screen opens. 

2.  On the General tab, enter the Description (name) of the security profile. 
We Recommend Use a descriptive name that will make it easy to choose the 
appropriate profile when creating user accounts. 

3.  On the Allowed Actions tab, check the kinds of functions users with this security profile 

may perform. Checking a parent function automatically checks the functions below it, 

although you can individually clear the child functions. 
Checking just the parent function (this requires checking it, then clearing all the child 

functions) provides view-only access to that function. 

4.  If setting up a security profile, on the Hidden Asset Types tab, check any asset types 
whose assets you do not want available to users with this security profile. 

5.  Click Save & Close. 

You can also use this screen to see which users have made changes to the system security 
profile and what those changes were (Audit tab). 

 

Setting up User Accounts 

Note: Be sure you are familiar with the overall concepts of user accounts before proceeding. 

To set up a user account: 

1.  On the User Accounts grid, click Add. 

The User screen opens. 

2.  On the General tab, enter the necessary information about the user (name, login 
name, e-mail address, and preferred language). 

Note: Login names must be unique in the system. Root Access Branch and Default 
Working Branch default to the company branch. 

3.  Choose the Security Profile this user account is assigned to or add a placeholder. 

4.  Optionally, choose the System Security Profile this user account is assigned to. 

5.  Check the options to indicate if this user must change their password at next login, 
and/or should receive alerts and/or MDT messages. 

6.  Click Save & Close. 
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Note: Encourage users to customize their interface so the quick access bar shows just those 

functions to which they have access. 

You can also use this screen to: 

• See which users made changes to the user account and what those changes were 

(Audit tab). 

• Lock a user account. 

From the user accounts grid, you can open the Audit Trail, a consolidated view of all Fleet 

Complete changes made by a user. 

 

Working with Users and Security 
 

Forcing Users to Change Their Password 

Use this function if a user's password has been compromised in some way. The user will be 
required to choose a new password when they next log in. 

Note: This function does not help a user recover a lost password. 

1.  On the User Accounts grid, double-click the user account. 

The User screen opens. 

2.  Check Must Change Password on Next Login. 

3.  Click Save & Close. 
 

Locking or Unlocking a User Account 
Use this function to temporarily or permanently prevent a user from having access to Fleet 

Complete. 

To lock or unlock a user account: 

1.  On the User Accounts grid, double-click the user account. 

The User screen opens. 

2.  Check or clear Lock Account, then click Save & Close. 
 

Viewing Audit Trail Details of Changes Made 

Use this function to see the details of changes made in Fleet Complete, for auditing and 

troubleshooting purposes. This function gives you a consolidated view of all changes made by 
a specific user. Keep in mind that you can also see, on the Audit tabs that appear on data 
entry screens throughout Fleet Complete, which users made changes to a specific item (such 
as an asset type) and what those changes were. 

1.  On the User Accounts grid, select the user you want to track and click Audit Trail. 

The User Audit Trail screen opens. 

2.  On the left, the screen lists the user's sessions in the last week. If necessary, choose a 

different start and end date for the range of sessions to display and click . 

3.  Select a session. The right side of the screen shows every change the user made 
during that session. 

 

Viewing When a User Last Logged In 

The User Accounts grid shows when each user last logged in. 
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CONFIGURING FLEET 
 

Background 
 

About Fleet Configuration 

Fleet configuration encompasses numerous optional and required functions. 

By default, your system has been configured with assets. However, you will want to modify or 
expand the configuration of those assets to meet your organization's specific needs. 

To set company-wide defaults and holidays, you need to configure your company. 

To take advantage of optional Fleet Complete features, you also need to perform additional 
Fleet configuration. By default, Fleet Complete collects and records detailed GPS and, where 
relevant, sensor or PTO data from all assets. This data is always available through reports. 

However, optional Fleet configuration functions allow you to make that data more meaningful 
for your organization. 

For Example The speed at which an asset is travelling will be viewable on a report, and you 

can filter that report to show just those assets whose speed is 120 kph or more. However, if 
asset speed is a concern, configure a rule that will monitor asset speed or percentage by 
which assets are exceeding the speed limit. 

 
The location of all assets will be viewable on a report, but to identify when locations of interest 
have been visited by assets, you need to configure POIs. 

 

If you want to... For example... You should 
configure this 

function... 
 

track driver behaviour or 
asset conditions 

 

record an event whenever an asset 
exceeds the speed limit or has been 

subject to harsh braking so you can 
correct inappropriate driver 

behaviour 

 

rules (without 
notifications) 

 

notify individuals of driver 
behaviour or conditions 

 

e-mail designated individuals when 
an asset's temperature exceeds a 
certain amount, so those individuals 
can contact the driver and ensure 
that the cargo is not damaged 

display an alert whenever an asset's 

GPS is invalid for a period of time, 
allowing a user to take corrective 
actions 

 

rules (with 
notifications) 

 

track the interaction of 
assets with specific 
geographical locations 

 

know when assets are at a refuelling 
station, so you can reconcile fuel 
receipts provided by drivers 

know when assets are at non- 
working locations, such as coffee 
shops, and for how long 

 

POI 

 

notify individuals about the 
interaction of assets with 
geographical locations 

 

e-mail a customer when any asset 
arrives at their location; note that 
this function should be used with 

caution, since it applies to all assets 
that interact with the location 

 

POI with contact 
e-mail 
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have an asset's interaction 

with a specific geographical 
location trigger a notification 

e-mail a customer when a specific 

asset, such as a snowplow, arrives 
at their location so they are aware 
the service is being provided 

display an alert when an asset of a 
particular type arrives at a supplier 
site, so users have the opportunity 

to ask the driver to pick up 
additional supplies if necessary 

POI and rules 

 

assign activities to 
individuals 

 

direct individuals to travel to a 
specific location to perform an 
activity such as stocking a machine 

 

resources 

 

assign activities to groups of 
individuals 

 

direct a group of individuals to travel 

to a specific location to perform an 

activity such as stocking a machine 

 

crews 

 

be able to report about 
supervision of resources and 
crews 

 

produce a management report that 
compares the performance of the 
different crews or resources working 

under a specific supervisor 

 

service groups 

 

record who is using a 
specific asset 

 

know who is operating an asset with 
specific events occur; know when a 
driver is in a vehicle and is working 

 

resources 

 

notify operators when a rule 

is triggered, so they can 
take corrective action 

 

e-mail a driver if their vehicle, which 

they take home overnight, is moving 
outside of working hours 

 

resources (with e- 

mail addresses 
defined) and rules 

 

capture run-specific 
information for reporting 

purposes 

 

generate a report that shows which 
assets operate on the Northwest run 

 

runs 

 

provide resources with 
appropriate messages and 
replies to be used for 

communication through MDT 
devices 

 

make standardized messages such 
as "yes", "no", "wait", and "don't 
know" available to resources 

 

canned messages 
and replies 

 

ensure vehicles remain in 
good repair 

 

have oil changes scheduled 
automatically for all relevant assets, 
to avoid unnecessary repair costs 

schedule annual safety expectations 
so they are not overlooked 

 

maintenance 

 
Opening the Fleet Configuration Screen 

1.  On the ribbon toolbar or main menu, click System > Configuration> Fleet 

Configuration. 

- or - 

On the ribbon toolbar, click Fleet and then the name of the function you want to 
configure. 
The Fleet Configuration screen opens. 
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2.  Available functions are listed on the left, in logical groups. 

3.  In the appropriate group, click on the function (for example, work schedules) you want 
to configure. You see a grid of existing items configured for that function. 

Note: To collapse a group, click  beside its name. To expand the group, click . 
 

Assigning Assets 
 

For Entities Other Than Rules 

To set or change which assets are assigned to an entity: 

1.  Click the Asset Assignments tab of the relevant screen (for example, asset type). You 
see a list of assets available to you. The assets currently assigned to the relevant item 
are checked. 

Note: Assets can be assigned to only a single asset type, device data setting, and 
work schedule. 

2.  To assign an asset individually, check it. 

- or - 

Click Quick Set (if available). To assign all assets of a particular type, check the 

Assign box beside the asset type's name. To clear assignments for all assets of a 
particular type, check the Unassign box beside the asset's type name. Quick Set 
choices do not change individual asset assignments. 

3.  If you used Quick Set, confirm the asset selections are correct. 

4.  Click Save & Close. 
 

For Rules 

To set or change which assets are assigned to a rule, do one of the following. 

On the Asset screen's Rule Assignments tab, check the rules to be assigned to the asset or 

click Assign All. Click Unassign All to clear selections. Confirm your choices and then click 
Save & Close. 
- or - 

On the Rule screen's Asset Assignments tab, check the assets to be assigned to the rule. To 

assign or unassign by asset type, click Quick Set, then check the Assign or Unassign box 
beside the appropriate type name. Click Save & Close. 

Note: Assets can be assigned to multiple rules or no rules at all. 
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About Work Schedules 
 

Why Use this Function? 

Configuring a work schedule for an asset and resource lets you distinguish between data 

collected while the asset/resource was working and data collected while it was not scheduled 
to work (for example, when an asset is being used on personal time). This lets you configure 
rules and produce reports that exclude data not related to scheduled work, or that focus 
exclusively on data collected during personal time. For resources, this feature can help verify 
that the resource is logging in/out within their work schedule parameters, identifying when the 
resource has an early or late start or works overtime. 

 

What is the Default Configuration? 

By default, all assets and resources use the same work schedule, which states they work 24 
hours a day, 7 days a week. This satisfies the requirement for work schedules, but does not 
distinguish work time from personal time. To gain the advantages of the work schedule 
function, you need to create your own work schedules. 

 

What Do I Need to Understand About Work Schedules? 

Work schedules do not affect the data collected or the visibility of the asset/resource: 

regardless of work schedule, data continues to be collected and information about the 
asset/resource continues to be visible on the Tracking Screen map. However, an asset's work 
schedule does determine what data is shown in the Asset Activity display, and can be used 
both in reporting and to determine the time period during which rules are triggered. 

 

Configuring System Defaults 
 

Why Use This Function? 

Use this function to change the default configuration of options that affect Fleet Complete 
users. Regardless of the settings, users can choose a different measurement unit when 
entering data. 

We Recommend Choose measurement units based on the conventions used by the greatest 

number of users in your organization. 
 

What is the Default Configuration? 

The default configuration depends on your country. 
 

What Do I Need to Understand About System Defaults? 

These settings can affect large numbers of Fleet Complete users and therefore should be used 
with caution. Access to this function should be restricted through security profiles, to avoid 
user confusion. 

 

How Do I Change System Defaults? 

To change system options: 

1.  On the ribbon toolbar or main menu, click System > Administration > Branches. 
The Branches grid opens. 

2.  Select your company (root) branch and click Edit. 

3.  On the General tab, specify the default Distance Unit (meters or feet). This is used 
throughout Fleet Complete whenever distance measurements are needed. 

4.  Specify the default Dimension Unit (cm or in) and Weight Unit (kgs or lbs). setting 
up package types 

5.  Specify the default Temperature Unit (Fahrenheit or Celsius). This is used when 
representing temperatures in temperature rules and the Asset Temperature report. 

6.  Specify the radius of the Departure Notification area. This function allows you to 
receive an e-mail when an asset moves outside a specific radius. This is a one-time 
notification that must be requested for a specific asset. 
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7.  Specify the default Country. This is used throughout Fleet Complete whenever 

distance measurements are needed. 

8.  Specify the default Time Zone. This is used throughout Fleet Complete whenever a 
timezone is needed. 

 

Setting Up Assets 
 

About Handheld Assets 
Fleet Complete supports two types of handheld assets. 

"True" devices, purchased specifically for Fleet Complete purposes, are tracked, used for 

receiving and reporting on activities, and, if MDT devices, used for messaging. They are 
configured as assets, with their own device data settings that determine how frequently (or on 
what days) information is sent from the asset to Fleet Complete. 

Dispatch-only devices are not tracked and are used simply for messaging, typically to 

supplement an in-vehicle tracked device. These devices are not configured as assets, but are 
associated with a specific resource. They can be used for receiving and responding to activities 
and, if MDT devices, for messaging. They communicate with the system every two minutes. 

 

About Asset Configuration 

Asset configuration involves several separate functions working together: 

• an asset's type groups it with other assets throughout Fleet Complete — actions can 

be taken on all assets of the same type (for example, you can hide assets of a 
particular type from the Tracking Screen map) and assets are identified by their type's 
icon on the map 

• an asset's Device Data Settings determine how frequently (or on what days) 

information is sent from the asset to Fleet Complete 

• an asset's work schedule specifies when the asset is considered to be working, so 
you can separate data collected during working hours from that collected outside those 

hours 

• an asset's vehicle type captures information useful for reporting, such as costs 
associated with the vehicle and whether it is meeting your utilization targets 

• an asset's home base is useful for monitoring and reporting on the asset's start and 
end of the work day (for example, to monitor for late departures) 

Prior to your access to your Fleet Complete system, Complete Innovations creates an asset for 
each device you have purchased. These asset records: 

• contain minimal information — you can choose to add to (for example, assign a 

resource to an asset) or change (for example, change the asset's name) an asset's 
configuration: more complex changes, such as changing the configuration of a sensor, 
should be done only in consultation with Fleet Complete technical support 

• are assigned to the "My Fleet" asset type — you will want to set up your own asset 
types and assign assets to them 

• are assigned to a device data setting — use caution when changing Device Data 

Settings, to avoid data overages 

• are assigned to a default work schedule that indicates they are available at all times — 

you will want to set up your own work schedules to reflect your organization's needs 

(if you do not set up work schedules, you will not be able to run reports that 
distinguish between data gathered during and outside of work schedules, or use rules 
that rely on work schedules) 

• have no relationship to each other — if you want to show, in reporting, a relationship 
between two assets (for example, between a handheld device and a vehicle, or 
between a truck and a trailer), modify the asset configuration 

 

 
Depending on the asset's device data settings, advanced configuration settings may be 
available. These include: 
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• which POIs should trigger an in-vehicle alert, and the output sensor that should be 

used for that alert — alerts are triggered when the asset leaves and enters the POI 

• the conditions under which device data settings should be overridden and a different 

transmission frequency to be used when those conditions are met (for example, you 
might want to have data transmitted more frequently while the asset's PTO is on and 
its speed is greater than a specific value) 

• whether or not the engine disable feature is to be used — this feature disables the 

starter if a driver ID Fob is not detected (note that this function relies on Output1, 
which must not be used for other sensors) 

• whether or not additional snapshots should be recorded when the vehicle's direction 
changes 

• whether or not the asset uses ECM 

Note: Overriding device data settings and recording additional snapshots when the asset 
changes direction will increase monthly data usage and, as a result, may increase costs. 

 

About Invalid Sensors 

Wherever sensors are listed in Fleet configuration (for example, when you configure sensor- 

specific rules), the icon appears if the sensor is invalid. Contact Complete Innovations 
technical support immediately for help fixing the sensor. 

 

Changing Asset Configuration 

Note: Be sure you are familiar with the overall concepts of asset configuration before 
proceeding. 

To change asset configuration: 

1.  On the Fleet Configuration screen, click Assets (in the left panel). 
A grid of existing assets and their details appears. The icons and colours shown on this 

grid are the same as shown in the Map Items area. 

2.  Select the asset you want to modify and click Edit. 

The Asset screen opens. 
 

 
 

3.  Complete the General tab (see below). 

4.  If rules have been configured, assign this asset to the appropriate rules on the Rule 

Assignments tab. 
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5.  If the asset has sensors defined for it, you can modify sensor configuration on the 

Sensors tab, but should do so only in consultation with Fleet Complete technical 
support. 

 

Note: If a sensor is invalid or configured incorrectly, the icon     appears. Contact 
Fleet Complete technical support immediately for help fixing the sensor. 

6.  If the asset has output sensors, complete the Advanced tab, in consultation with Fleet 
Complete technical support. 

7.  Click Save & Close. 
 

Completing the General Tab 

Make only the changes that are necessary. 

1.  Change the Description (name) of the asset. 

Note: You may prefer to name assets based on vehicle number or license plate, rather 
than driver name, since the driver is likely to change over time. 

2.  Choose the appropriate asset Type or add a placeholder. 

Note: Do not adjust the Device ID unless directed to by Fleet Complete technical 
support. 

3.  The Device Data Settings appropriate for the selected device were set up by 
Complete Innovations. Under normal circumstances, you should leave this setting 

unchanged: choosing a different device data setting may result in overage charges. 

4.  Choose the appropriate Work Schedule for the asset. 

5.  An asset can be related to another asset, for reporting purposes. If you want to use 

this function, choose a Related Asset. 

Note: The asset being modified is considered the parent of the related asset: the 
configuration of the related asset does not show this relationship. 

6.  A specific resource/crew can be assigned to an asset, for reporting purposes. If you 
want to use this function, choose the appropriate Resource/Crew. 

Note: Manually assigning a resource to an asset is not recommended for MDT and/or 

driver ID Fob resources. Instead, have resources recognized by their PIN or driver ID 
Fob. 

7.  A specific run can be assigned to an asset, for reporting purposes. If you want to use 
this feature, choose the appropriate Run. 

8.  If using the vehicle types feature, choose a Vehicle Type. 

9.  Choose the POI that constitutes the Home Base for the asset (used to report on 
departure and arrival times). 

10. If MDT integration is being used, check Enable MDT Integration, choose the 
appropriate MDT Device, and choose the Canned Message Group and Canned 
Reply Group to be used for communication with the driver of this asset. 

11. If you will be using the Maintenance function, you can enter Vehicle Information 
here. (This information can also be added in the Maintenance function itself.) 

12. Enter values for custom fields, if any have been set up. 
 

Completing the Advanced Tab (If Applicable) 

To have an in-vehicle alert (driver notification) be triggered when an asset enters or exits a 
POI, choose the appropriate POI and choose the Output Sensor. If you will be using the 

engine disable feature for this asset, do not choose Output1 for this function. 

To have data transmitted at a different frequency based on specific conditions. choose from 
the available sensors and enter the value to be used for the calculation, then enter the 
transmit override value. 

To have the starter disabled if a driver ID Fob is not detected, check Supports engine 
disable. 
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To record additional snapshots when vehicle direction changes (defined as a 30 degree change 

in direction for at least five consecutive seconds), check Record additional positions 
when... 

To use ECM, check Has ECM. 

CAUTION: If the device is not an ECM, selecting an ECM type will disable the normal reporting 
functionality of the device (e.g. Trip Replay). 

You can also use this screen to see which users made changes to the asset and what those 
changes were (Audit tab). 

 

About Asset Types 
 

Why Use this Function? 

Use this function to associate assets together so you can work with them as a group. Asset 

types simply group assets together: they do not determine any characteristics of the assets 
themselves. For example, assets used to perform different types of work, that collect data at 

different intervals, or that have different work schedules can all be part of the same type. 

We Recommend If you want users to work only with assets for their area of responsibility or 

geographical location, set up asset types for regions, provinces, or states. You can then 
restrict users (through security profiles) to working with only assets of the relevant type. 
If you want to be able to report on assets operating within or outside of their work schedule, 
create asset types for each work schedule. This will ensure that reports include data gathered 

over the same lengths of time. 
 

What is the Default Configuration? 

A single My Fleet asset type is configured, and all assets are assigned to this type. My Fleet 
identifies assets on the map with a star icon. 

 

What Do I Need to Understand About Asset Types? 

Asset types are used throughout Fleet Complete, so give careful consideration to how you 
want to use them. 

Asset types are used in: 

• security profiles, to determine which assets users can have access to 

• the Tracking screen, to organize assets and allow them to be shown or hidden as a 
group 

• reporting, to report on all assets of a specific type 

• the Tracking screen map, to determine the icon that represents assets on the map 

• asset assignment, to quickly assign all assets of a type 
 

 
Asset types might be set up for assets with different: 

• services (long distance vs. short distance drivers) 

• types of operator (installers, operators, supervisors) 

• types of vehicles (snowplows, tow trucks, or cars) 

• locations (regions, states, provinces) 

• sizes or purposes of assets 

• sensors 

• work schedules (morning shift, afternoon shift, evening shift, weekend shift) 
 

Setting up Asset Types 
Note: Be sure you are familiar with the overall concepts of asset types before proceeding. 

To set up an asset type: 

1.  On the Fleet Configuration screen, in the Assets group, click Types. 
A grid of existing asset types and their details, including the number of assets of that 
type and whether that type is currently set to show and/or be labelled on the Tracking 

Screen map, appears. 
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2.  Click Add. 

The Asset Type screen opens. 

3.  On the General tab, enter a Description (name) for the asset type and choose the 
default Map Image to represent assets of this type on the map. 

4.  To assign assets to this type, use the Asset Assignments tab. 

Note: If you are modifying an asset type and your security profile does not allow you 

to view assets that are assigned to that type, a message indicating the number of such 

"hidden" assets appears at the bottom of the Asset Assignments tab. 

5.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the asset type 
and what those changes were (Audit tab). 

 

Setting up Work Schedules 
Note: Be sure you are familiar with the overall concepts of work schedules before proceeding. 

To set up a work schedule: 

1.  On the Fleet Configuration screen, in the Assets group, click Work Schedules. 

A grid of existing work schedules and their definition appears. 

2.  Click Add. 

The Work Schedule screen opens. 

 

3.  On the General tab, enter a Description (name) for the work schedule. 

4.  Enter the grace period for Departure and Return. This is used to determine when an 
asset or resource is late departing (late departure rule) from or returning to its home 
base. For example, if the Departure Grace is 15 minutes and the work schedule calls 

for the resource to start work at 8:30 am, the resource will not be considered late until 

8:45 am. The Work Schedule report excludes data from the grace period. 

5.  Specify the hours for the work schedule. 

For Example An asset is used during business hours on weekdays. 
You configure the following schedule: 
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A paramedic does night shift work, working Sunday through Thursday nights from 6 
pm until the next morning at 6 am. You configure the following schedule: 

 
 
 
 
 
 
 
 
 
 
 

6.  To assign assets to this work schedule, use the Asset Assignments tab. 
To assign resources to this work schedule, on the Resource Assignments tab, check 
the appropriate resources. 

7.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the work 
schedule and what those changes were (Audit tab). 

 

About Device Data Settings 
 

Why Use this Function? 

Device data settings determine how frequently (or on what days) snapshots are sent from an 
asset to Fleet Complete. These settings are used to ensure that the asset complies with the 
requirements of your wireless service. 

Note: To avoid service overages, use caution when modifying these settings or creating new 
ones and assigning them to assets. 

 

What is the Default Configuration? 

By default, all assets based on the same product use the standard device data settings 

established for that product (your organization can subscribe to different products). In 
general, these settings will meet your needs while ensuring you are operating within the 
parameters of your wireless service plan. 

 

What Do I Need to Understand About Device Data Settings? 

Device data settings vary depending on the Fleet product being subscribed to. 

For in-vehicle tracking and resource tracking (part of Complete Innovations' advanced 
bundle), device data settings control: 

• how frequently devices in a vehicle record data, and how frequently they send snapshots 
to Fleet Complete 

• whether or not the assets use DCM 

For asset tag/LBS tracking, device data settings control the hours in the day during which 

snapshots are sent. By default, these settings are 9 am to 5 pm on weekdays. If using this 
form of tracking for loss prevention, change the settings to capture data constantly. 
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Setting up Device Data Settings 
Note: Be sure you are familiar with the overall concepts of device data settings before 
proceeding. 

To set up device data settings: 

1.  On the Fleet Configuration screen, in the Assets group, click Device Data Settings. 

A grid of existing device data settings and definitions, grouped by product, appears. 

2.  Click Add and choose the product the settings apply to. 

The appropriate screen opens. 

3.  Complete the General tab (the fields differ depending on the product chosen). 

4.  To assign assets to this device data setting, use the Asset Assignments tab. Note that 

this tab will show only those assets that belong to the selected product. 

5.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the device data 

setting and what those changes were (Audit tab). 
 

About Vehicle Types 
 

Why Use this Function? 

This function allows you to capture additional information (related to costs and utilization 
targets) for vehicles. It is used for the Asset Utilization management report. 

 

What is the Default Configuration? 

No vehicle types are configured by default. 
 

What Do I Need to Understand About Vehicle Types? 

You need to create your vehicle types, then associate them with assets. Vehicle types have an 
associated cost used in reporting. 

 

Setting up Vehicle Types 

Note: Be sure you are familiar with the overall concepts of vehicle types before proceeding. 

To set up a vehicle type: 

1.  On the Fleet Configuration screen, in the Assets group, click Vehicle Types. 

A grid of existing vehicle types appears. 

2.  Click Add. 
The Vehicle Type screen opens. 

3.  On the General tab, enter a Description (name) for the asset type. 

4.  Enter a Mileage and/or Hourly cost to be associated with assets of this type (shown 
in reports). 

5.  Choose the Maximum Weight of assets of this type. 

6.  Enter the target Utilization Percentage of assets of this type. 

7.  To assign assets to this type, change the asset's configuration. 

8.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the vehicle type 
and what those changes were (Audit tab). 

 

Changing Asset Tag (LBS) Device Data Settings 
Note: Be sure you are familiar with the overall concepts of device data settings before 
proceeding. 

To set up asset tracking (LBS) device data settings: 

1.  On the Fleet Configuration screen, in the Assets group, click Device Data Settings. 
A grid of existing device data settings, grouped by product, and their definition 
appears. 
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2.  Select the Asset Tag/LBS device data setting you want to change and click Edit. 

The Device Data Setting screen opens. 

3.  On the General tab, check each day and hour within the day during which assets 
associated with this device data setting should track data. If tracking is being used for 
loss prevention, check every hour of every day. 

4.  To assign assets to this device data setting, use the Asset Assignments tab. Note that 

this tab will show only those assets that belong to the selected product. 

5.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the device data 
setting and what those changes were (Audit tab). 

 

Setting up Rules 
 

About Rules 
 

Why Use this Function? 

Without rules, the data collected based on the asset's GPS and sensor readings is simply 
stored as transmitted. You can track real-time asset movements on the Tracking screen and 
review detailed data through reports. However, you may want to be proactive in your tracking 

by flagging events of interest as they happen. 

For Example An asset exceeds the speed limit several times on Monday. Someone monitoring 
the asset on the map might notice that it exceeded the speed limit, but only if they were 

watching the asset closely. On Tuesday when you run a Speeding report you see which assets 
were speeding on Monday, but have lost the chance to notify drivers while the situation was 
actually occurring. 

All rules can save your organization money, but the specific rules you choose, and how you 
configure them, dictate the value that rules offer. 

For Example A harsh braking rule can save money when it identifies driver behaviour that 

may affect the life of the vehicle. 

Rules allow you to track the behaviour of assets and/or the readings of the asset's sensors. 
Rules can be used to monitor assets for incorrect behaviour (speeding, or harsh braking), to 

ensure data integrity (invalid GPS), to ensure cargo safety (unacceptable temperature or 
humidity), or to ensure personal safety (panic button), to name just a few. 

When a rule is triggered, an event is recorded. The event appears on the Tracking screen and 

in the Event report. In addition, you can have an event configured to send a notification. 

You can choose to have rules triggered immediately or after a delay (for example, you might 
want to wait five minutes to establish that a vehicle is speeding consistently before a speeding 
rule is triggered). You may have a different notification (for example, notify a different person) 
if the asset continues to trigger the rule for a continuous period of time. 

 

What is the Default Configuration? 

Some commonly used rules have been configured by default (these are prefixed with the word 

"Default"). You may want to modify them to suit your organization's needs. 
 

What Do I Need to Understand About Rules? 

There are many different types of rules, some of which rely on assets having a particular 
sensor. 

Rule details vary based on type, but most rules consist of: 

• the rule's name 

• the parameters that define the rule (for example, the speed at which an asset needs 
to be travelling to trigger the rule) 

• the amount of time to wait, after a rule has been triggered, before recording an event 

• whether you want notifications sent when a rule is triggered and, if so, what kind of 
notifications to produce and who is to receive them (see below) 
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• whether rules should be considered only during the asset's work schedule, only 

outside the asset's work schedule, or anytime 
For Example You may be concerned with an asset's temperature only while it is 

working. 

• whether the asset's interaction with POIs should be taken into account when 
determining if a rule should be triggered 
For Example You may want to know when a vehicle is stopped and not at any client 

site, or when a vehicle is stopped at a specific warehouse. 

• the assets to which the rule applies 
 

What Happens if a Rule is Triggered? 

When a rule is triggered, an event is recorded. In addition, you can choose to have one or all 
of the following notifications occur: 

• create an alert 

• e-mail the resource currently assigned to the asset that triggered the rule 

• e-mail specific Fleet Complete users 

• send an e-mail to a specific e-mail address (non-Fleet Complete user or alternate 
address for a Fleet Complete user) with information about the event 

Generally speaking, use notifications only for those events that need immediate attention: all 
events will appear in the Event report for later analysis. 

For Example Critical events, such as "outside work hours usage", trigger an e-mail to your 

security staff, for quick theft detention. 
To deter inappropriate driver behaviour, when an asset triggers a speed limit rule, an e-mail is 
sent to the resource's manager. 
The lowering of a plow while a snowplow is at a customer's office results in an e-mail to that 

customer, making them aware that their snow plowing service is being provided. 
 

Types of Rules 

A variety of types of rules are available. Note that some rules depend on asset sensors being 
available: for example, a temperature rule can only be assigned to assets that have a 

temperature sensor. Rules that rely on sensors are marked with an * below. 
 

Use this type of 
rule... 

When you want to know if... 

 

Analog* an asset's sensor readings fall outside a specific range (for 
example, a battery’s voltage is below a certain level), potentially 
indicating a problem with the asset 

 

Antenna 

Malfunction 

 

an asset's antenna has stopped working (for example, has a short 
or has been disconnected); applies only to assets that have in- 
vehicle tracking 

 

Code* a defined code transmitted by a sensor equals or does not equal a 
value (for example, the vehicle moved with no ignition state 
change), indicating a potential problem 

 

Distance an asset moves more than a defined distance 
 

First Ignition an asset's ignition is turned on for the first time within its work 
schedule 

 

GPS Lost an asset's GPS signal has been lost; applies only to assets that 

have in-vehicle tracking 
 

Harsh Braking* an asset's in-vehicle device sensor indicates it is being driven 
harshly (while braking); applies only to assets that have in-vehicle 
tracking 
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Harsh Cornering*     an asset's in-vehicle device sensor indicates it is being driven 

harshly (around corners); applies only to assets that have in- 
vehicle tracking 

 

Humidity* an asset's sensor indicates its humidity falls outside a specific 
range, indicating a potential risk to the vehicle's cargo 

 

Idle an asset's position remains constant with the ignition on (for 
example, the driver is leaving the vehicle without turning it off), 
indicating a potential security risk and/or added fuel costs (a rule 
of this type is configured by default) 

 

Illegal Power Off an asset has lost power while not in DCM; applies only to assets 
that have in-vehicle tracking 

 

Input* an asset's input sensor has changed its state (for example, door is 
open or closed), indicating a valid reason for the vehicle to be idle 

(for example, it is loading supplies) 

the asset's ignition state can also be taken into account, for 
example, the door is open while the ignition is on 

 

Invalid GPS an asset's GPS is not providing enough valid information (perhaps 
the antenna is not in an optimal position), allowing you to take 
preventative measures to ensure you are always receiving and 
recording accurate data 

 

Late Departure an asset was late leaving its home base, indicating a potential 

work performance issue — the grace period associated with the 
resource's work schedule or, if no resource is assigned, the grace 
period associated with the asset itself, is taken into account when 
determining lateness 

 

Outside Work 

Hours Usage 

 

an asset's ignition is turned on outside of its work schedule, 

indicating a potential use of the asset for personal reasons or a 
potential theft 

 

POI an asset enters or exits a POI, indicating a potential problem 
(entering an inappropriate location) or opportunity (entering an 
appropriate location) 

an asset remains within a POI for more than the configured time 
(for example, the driver is remaining at a client site for longer 
than should be necessary, compromising customer server for 

subsequent clients) or less than the configured time (for example, 
the POI is the site for a safety check which should take at least 15 
minutes, so leaving earlier may indicate the check was not done) 

 

Racing an asset's speed exceeds the speed limit by a specific value for 
more than 2 consecutive minutes 

 

Rapid 

Acceleration* 

 

an asset's sensor indicates it accelerates by more than 11 km/h in 
2 consecutive seconds, indicating a potential problem with driver 
behaviour (a rule of this type is configured by default) 

 

Speed an asset exceeds a specific speed, indicating a potential problem 
with driver behaviour 

 

Speed Limit an asset exceeds the speed limit by a specific percentage of the 
allowed limit, indicating a potential problem with driver behaviour 
(a rule of this type is configured by default) 

 

Still an asset's position remains constant, indicating a potential 
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problem with driver behaviour; use in conjunction with a POI rule 
to ensure this rule is not triggered when the vehicle is in a 

legitimate location such as your company's parking lot 
 

Super the parameters set in more than one type of rule have occurred 
simultaneously (for example, an asset's sweeper is engaged while 
the asset is travelling above a safe speed for the use of that 
sweeper) 

 

Temperature* an asset's sensor indicates its temperature falls outside a specific 
range, potentially indicating risk to the vehicle's cargo 

 

Unauthenticated 
Resource 

 

an asset's ignition is on but the resource has not been 
authenticated by a driver ID Fob, potentially indicating a security 
problem 

 
 
 

Setting up Rules: Overview 

Note: Be sure you are familiar with the overall concepts of rules before proceeding. 

These instructions do not apply to super rules. 

To set up rules: 

1.  On the Fleet Configuration screen, in the Assets group, click Rules. 
A grid of existing rules, their type, and a summary of each rule's definition, appears. 

2.  Click Add and choose the type of rule you want to create. 

3.  The details of the rule screen that appears vary depending on type. 

Sample Screen 
 

 
 

4.  Enter a Description (name) for the rule. 

5.  Define rule parameters (these vary depending on rule type). 

6.  Define rule restrictions (what work schedules or POIs, if any, should be taken into 
account when determining if a rule has been triggered). 

7.  Define rule notifications (what notification, such as an alert or an e-mail, is to occur 

when a rule has been triggered). 

8.  To assign assets to this rule (these assets will have their behaviour and sensors 
monitored for conformance to the rule), use the Asset Assignments tab. 

Note: Assets with more than one sensor will be listed once per sensor on the Asset 

Assignment tab. If a sensor is invalid, the icon     appears. Contact Fleet Complete 

technical support immediately for help fixing the sensor. 

9.  Click Save & Close. 
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Note: You can also use this screen to see which users have made changes to the rule and 

what those changes were (Audit tab). 
 

Setting up Rules: Rule Parameters 
1.  In the rules screen, enter the rule parameters specific to the rule type, if any. 

 

For this 

rule 
type... 

Define... 

 

Analog the acceptable values for the sensor (values outside this range will 
trigger a rule) 

 

Code the code value that triggers the rule (if equal to or not equal to the 
specified value); known codes are: 

4 = movement of 1000 meter + ignition is off 
 

Distance the distance beyond which an asset must move to trigger the rule 

how long the asset must be stopped before the distance counter is 
re-set 

For Example The rule is defined to trigger if the asset moves more 
than 500 meters and reset the counter after 5 minutes. If the asset 
moves 400 meters, stops, then moves again after 2 minutes, the 

rule will be triggered if the asset moves without stopping for another 

100 meters. 
 

Humidity the acceptable percentage range of humidity for the asset (readings 
outside this range will trigger the rule) 

 

Input the state of the input sensor (on, off, open, or closed) and state of 
ignition (any, on, or off) that triggers the rule 

 

POI the length of time the asset remained within the POI 

for "less than", the event will be triggered if the asset leaves the POI 

and has stayed less than the configured time 

for "greater than", the event will be triggered once the time has 
elapsed or, if the asset is asleep, as soon as the asset wakes up and 
it is determined that the specified time has elapsed 

 

Racing the fixed speed over the speed limit the asset must be travelling to 
trigger the rule 

 

Speed the speed the asset must exceed to trigger the rule 
 

Speed 
Limit 

 

the amount over the speed limit (either a fixed value or a 
percentage) the asset must be travelling to trigger the rule 

 

2.  Specify when the rule is Triggered (after a specific period of time has passed, or 
immediately). (Not applicable for distance rules.) 
For Example To avoid having a rule triggered by a temporary condition, such as 

when a vehicle's speed is temporarily increased when passing another vehicle, set a 
delay in triggering the rule, such as 3 or 4 minutes. 

Note: For the Invalid GPS rule, allow a reasonable amount of time, such as half an 
hour, to pass before triggering the rule. The asset may simply be in an underground 

facility or loading area where GPS signals are weak. 

3.  If you want repeat occurrences of a triggered rule to result in additional events, from 
the Repeated list choose "every" and specify the frequency with which the event will 

be repeated. You can specify a different notification for repeated triggers than was 
used for the initial trigger. 



Fleet Complete User Guide 50 

Configuring Fleet Setting up Rules  

 

 

 
For Example If an asset exceeds the posted speed limit for 4 minutes, you want an 

event recorded. If it continues to exceed the posted speed limit for another 15 
minutes, it has now been speeding for 19 minutes and you want an e-mail message 
sent to the driver's manager. 

4.  Set up rule restrictions. 
 

Setting up Rules: Restrictions 
1.  In the rules screen, choose if you want work schedules taken into account when 

determining if a rule has been triggered. If work schedules are to be taken into 
account, choose a Work Schedule Reinforcement: rules can be triggered either 
during or outside the work schedule. 

For Example 

You may want to know if an asset triggers a POI rule, such as one that occurs if a 
vehicle is at a casino, only when that asset is scheduled to be working. 

2.  If POIs are configured, choose if you want those taken into account when determining 

if a rule has been triggered. By default, POIs are ignored. Note that POI rules are 
triggered only by the assets assigned to this rule. 

3.  If POIs are to be taken into account, choose a POI Restriction Type: 
 

To have events triggered 
when the asset is... 

Choose this POI restriction type... 

 

anywhere None 
 

in any POI that has been 
configured 

 

In Any POI 

 

in only specific POIs In Specific POI, then check each POI type and/or 
POI to be taken into account 

 

not in any POI that has been 
configured 

 

Not in Any POI 

 

not in specific POIs Not In Specific POI, then check each POI type 
and/or POI to be taken into account 

 

For Example You want a rule triggered if an asset remains at client offices for more 
than 30 minutes. You choose a restriction of "In Specific POI" and then choose the 
POIs that represent client offices. 

You want to ignore the length of time an asset remains idle if it is in a legitimate 
location such as a parking lot or yard. You choose a restriction of "Not in specific POIs" 
and choose the POIs that represent such locations. 
You want to know if a vehicle is speeding regardless of where it is located. You choose 

a restriction of "None". 

4.  Set up rule notifications. 
 

Setting up Rules: Notifications 

1.  In the rules screen, choose the Initial Notification (you can choose more than one) 

that should occur when the rule is triggered. You can choose to: 

• have an alert appear to all users whose security profile allows them to see 
alerts — check Alert Users 

• send an e-mail message to the resource currently assigned to this asset — 
check E-mail Resource/Crew 

• send an e-mail message to Fleet Complete users — check E-mail User(s) and 
then check the appropriate user name(s) 

• send a message to someone else, such as a customer — check E-mail 
Recipient(s) and enter the appropriate e-mail address(es) 
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2.  If you chose to alert users, optionally choose the Sound to play when an alert is 

received. 

Tip: Sounds can be used to help identify the importance of the received alert. The 
sound used for initial and repeated events is the same. 

3.  If you chose an e-mail notification, on the E-mail Options tab, choose the Language 

of the e-mail, choose up to three fields to appear in the Subject of the e-mail 
message, and check or clear the checkboxes in the Body Fields area to identify the 
fields that should make up the e-mail message's body. 

Note: Depending on the type of rule you are configuring, some Body Field 

choices cannot be cleared. 

Contents of E-mail Message 

The rule notification e-mail includes: 
* the words "Rule Notification" in the subject line 

* the address where the event took place 

* the asset's name, type, and other identifying information 

* description of the event 

* time/date the event occurred 
 

4.  If you chose to track repeat occurrences of a triggered rule, choose the Repeat 
Notification that should occur when the rule continues to be triggered (same options 
as for the initial notification). 

5.  If the rule should be automatically assigned to all new assets that Complete 
Innovations provisions for you, check Assign this rule by default. 

6.  Assign assets to rules. 
 

Setting up Rules: Assigning Assets 

1.  In the rules screen, use the Asset Assignments tab. 

Note: Assets with more than one sensor will be listed on the Asset Assignment tab 
once for each sensor. 

2.  Click Save & Close. 
 

Setting up Super Rules 

To set up super rules: 

1.  On the Fleet Configuration screen, in the Assets group, click Rules. 

A grid of existing rules, their type, and a summary of each rule's definition, appears. 

2.  Click Add and choose Super Rule. 

3.  Choose the type of rules that will make up the super rule. You can combine no more 
than three rule types and only one of those can be a sensor-based rule type (indicated 

on the interface by a . 

Note: It is possible to select rule types that are illogical, such as selecting both 
"distance" and "still" types, which will produce irregular or no results. 

Show Screen 

4.  Click Continue. The screen that appears is similar to that of regular rules, but shows 
parameters for the selected rule types. 
Show Sample Screen 

5.  Enter a Description (name) for the rule. 

6.  Define rule parameters (these vary depending on rule type): general parameters 
appear below the restriction, rule type-specific parameters appear in the Rule Items 
area). 

7.  On the Notifications sub-tab, define rule notifications (what notification, such as an 
alert or an e-mail, is to occur when a rule has been triggered). 

8.  Define rule restrictions (what work schedules or POIs, if any, should be taken into 

account when determining if a rule has been triggered). 
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9.  To assign assets to this rule (these assets will have their behaviour and sensors 

monitored for conformance to the rule), use the Asset Assignments tab. 

Note: Assets with more than one sensor will be listed once per sensor on the Asset 

Assignment tab. If a sensor is invalid, the icon     appears. Contact Fleet Complete 

technical support immediately for help fixing the sensor. 

10. Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the rule and 
what those changes were (Audit tab). 

 

Setting up Runs 
 

About Runs 
 

Why Use This Function? 

Runs are simply names you grant to specific travel that an asset typically does (such as the 

run that takes an asset to customer sites in the eastern region). Runs are used for reporting 
purposes, and their assignment to assets appears in the Map Items panel of the Tracking 
screen, but runs do not appear on the map itself. 

 

What is the Default Configuration? 

By default, no runs are configured. 
 

What Do I Need to Understand About Runs? 

Runs are used only for reporting purposes. 
 

Setting up Runs 
Note: Be sure you are familiar with the overall concepts of runs before proceeding. 

To set up a run: 

1.  On the Fleet Configuration screen, in the Assets group, click Runs. 
A grid of existing runs, and their associated assets, appears. 

2.  Click Add. 

3.  In the screen that opens, enter a Description (name) for the run. 

4.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the run and what 

those changes were (Audit tab). 

 

Setting up POIs 
 

About Points Of Interest (POIs) 
 

Why Use This Function? 

Without POIs, all locations an asset visits are considered of the same significance. Configuring 
POIs allows you to track and report on the interaction of assets with specific locations that are 
important to your organization. Examples of POIs include customer sites, warehouse locations, 

border crossings, prohibited zones, and refuelling stations. Defining a POI can help ensure that 

your assets are in appropriate work locations, working efficiently, and/or are secure. POI- 
specific reports allow you to compare data for several different assets or to report on unvisited 
POIs, for greater customer service. 

For Example To ensure efficiency, you want to know how long a vehicle waits at a border 

crossing, when it arrives at a supplier's location, or when it leaves a refuelling station. 
To provide customer service, you want to know when an asset arrives at or leaves a customer 
site. 

For security purposes, you want to know if an asset is travelling inappropriately, such as on 
residential streets. 
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For employee performance assessment purposes, you want to know when an asset is at a 

personal location such as a coffee shop or shopping mall. 

For budgetary purposes, you want to know when assets are travelling on toll roads where tolls 
are charged to your organization. 
For validation purposes, you want to ensure that information in the receipts you receive from 
a driver for refuelling costs correspond to the time that the company asset was at a refuelling 

station. 
 

What is the Default Configuration? 

By default, no POIs are configured, but a default POI type is provided. 
 

What Do I Need to Understand About POIs? 

All POIs are associated with all assets. To capture data about a specific asset's interaction with 
a POI, use a POI rule. 

Each POI has a type which determines its appearance on the map. A POI also has a category 

which is used to group it with similar POIs for reporting purposes (for example, there is a 

"supplier" and a "client" category). 

A POI's configuration determines the geographical location (bounded by a circle, line, or area) 

of the POI. Optionally, you can also define: 

• the working hours for the POI (this can be useful to determine if an e-mail notification to 
a POI contact is necessary, , and to populate the Curfew report 

• custom fields 

• a contact person at the POI 

• e-mail notifications to be sent in relation to the POI 

Because POIs are not assigned to assets, use the contact e-mail notification function with 
caution. Any asset's interaction with the POI will trigger the e-mail notification, even if that 
interaction is not significant to the contact. 

For Example A lunch truck service might want to e-mail a client when a lunch truck arrives at 
their office. However, if a delivery truck from that company also arrives at the client's office 

(to make a pick-up), the same e-mail notification is triggered. 
To avoid this situation, use POI rules. 

A single POI can overlap with other POIs, for example, a POI might include an entire city block 
and that block might contain two specific client office POIs. Data will be collected about each 

POI an asset visits. 

For Example A POI covers an entire facility, with separate POIs for each factory and the 
security kiosk at the facility. When an asset arrives at the facility, they are deemed to have 

arrived at the facility POI, so an e-mail notification is sent. When they arrive at the security 
kiosk, they are deemed to have arrived at the security kiosk POI as well as at the facility POI, 
so another e-mail notification is sent. 

 

How do POIs Work with Rules? 

A rule can take POIs into account, with events triggered only when an asset it in or not in a 
POI. 

A POI rule can be defined to deliver a notification (for example, to a customer) when a 

specific asset arrives at or leaves a POI. 

For Example A lunch truck service wants to e-mail a client when a lunch truck, rather than 
any other type of asset, arrives at the client's office. 
A snowplow service wants to e-mail clients when the plow arrives (indicating that the parking 
lot is being plowed) and when it leaves (indicating that the parking lot has been cleared). It 

does not want this notification sent if another asset visits the client's location. 

A company wants to have an alert sent when a high-capacity asset arrives at a warehouse, so 
that the warehouse staff is prepared. 

 

How do POIs Work with Activities? 

Activities are associated with a specific POI. 
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Setting up POI Types 

Note: Be sure you are familiar with the overall concepts of POIs before proceeding. 

We Recommend Set up at least two POI types: one for locations you want to track on the 
map, and one for locations used for reporting or rules. 

1.  On the Fleet Configuration screen, in the Points of Interest group, click Types. 
A grid of existing POI types appears. The grid also shows the name and icon used to 
represent POIs of that type, the number of POIs of that type, and whether that type is 
currently set to show and/or be labelled on the Tracking Screen map. 

2.  Click Add. 

The Point of Interest Type screen opens. 
 

 

3.  On the General tab, enter a Description (name) for the POI type. 

4.  Choose the default Map Icon to be used to represent POIs of this type on the map. 

5.  Choose the default colour to be used for the Line and Fill representing the borders of 

POIs of this type on the map. 

We Recommend Choose colours that indicate to the user the importance or 
significance of POIs of that type. For example, if you are creating POIs for potentially 

dangerous locations, you might give their POI type a red fill. 

6.  Choose the Line Thickness to be used for the border of POIs of this type on the map. 

7.  On the POI Assignments tab, check those POIs to be assigned to this type. 

8.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the POI type and 
what those changes were (Audit tab). 

 

Setting up POIs: Overview 
Note: Be sure you are familiar with the overall concepts of POIs before proceeding. 

You can set up POIs in any of the following ways: 

• from the configuration screen (described here) — you will need to navigate to the map 
location for the POI 

• from the map (described here) — the position of the cursor on the map will be used as 

the centre of a circular POI area (a fast way to add POIs) 

• by importing 

• when creating an activity 

1.  On the Fleet Configuration screen, in the Points of Interest group, click Points of 
Interest, and click Add. 

2.  The Point of Interest screen opens. 

- or - 
Right-click on the Tracking Screen map at any location and choose Add POI Here. 

The Point of Interest screen opens. 
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3.  Complete the General tab. 

4.  Optionally, complete the Details tab. 

Note: You can also use this screen to see which users have made changes to the POI and what 
those changes were (Audit tab). 

 

Setting up POIs: General Tab 
1.  On the POI screen's General tab, enter a Description (name) for the POI. 

2.  Specify the address for the POI. 

3.  Optionally, enter a unique identifying Code for the POI. This appears in reports and 

can be used like an account number. 

4.  Choose this POI's Type or add a placeholder. 

5.  Choose this POI's Category (this is a fixed list of categories used for reporting 

purposes). 

6.  Choose the Time Zone in which the POI exists. 

7.  Optionally, enter descriptive Notes. 

8.  Optionally, complete the POI Details tab. 
 

Setting up POIs: Details Tab 
1.  On the POI screen's Details tab, if you want to specify working hours for the POI, 

complete the Working Hours area. This is especially useful for the Curfew report. 

2.  If you want to enter custom fields for the POI, click the Details tab and complete 
them. 

3.  If you want to record a contact person at the POI, enter the contact's name, phone 

numbers, and e-mail address(es), separated by semicolons. 

4.  If you want to e-mail someone when an asset is at this POI (use this function with 
caution, since any asset's interaction with the POI will trigger the e-mail), check E- 
mail Contact. Default e-mail text appears. 

a.  Enter a Subject for the Arrival (sent when the asset enter the POI) and/or 
Departure (sent when the asset leaves the POI) message. 

b.  Change or add to the default E-mail Text for the arrival or departure message. 

Optionally, insert one of the following variables in the text: @Resource, @Asset, 

@Date, and/or @Time. 
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For Example The text "Notification: @Resource (@Asset)departed Starbucks- 

09856 on @Date at @Time" 
becomes 
"John Smith (snowplow-001 ) departed Starbucks-09856 on 1/29/2010 at 7:39 

AM. 

c. Optionally specify Notification Restrictions to restrict e-mail notifications to 

being sent only within or outside of the POI's working hours. 

d.  Set a Delay interval: Fleet Complete will wait for that time to elapse before 
sending the e-mail. 

5.  Click Save & Close. 
 

Importing POIs 

Note: Be sure you are familiar with the overall concepts of POIs before proceeding. 

The file to be imported must be a CSV format file, with the first row specifying column names. 
Fleet Complete will prompt you to match the columns in the CSV to the appropriate POI fields. 

Street, City, and Province or Longitude/Latitude must be specified in the CSV. (If you specify 
Longitude/Latitude, other address information in the file is imported, but is not required.) 
Other fields are optional but you may want to include them so your POI configuration data is 
as complete as possible. 

Example CSV 

All POIs created by the import process are created as circles around the specified addresses. 

All POIs in the same CSV file are created with the same type, buffer (radius), POI contact e- 
mail notification delay, and category, although these can be changed later. If you have 
addresses you want treated differently (for example, you want to assign POIs to several 
different POI types) put them in separate files and import them individually. 

1.  On the Fleet Configuration screen, in the Points of Interest group, click Points of 

Interest, then click Import. 

The Import Points of Interest screen opens. 

2.  Click Browse and navigate to the location of the CSV file, opening the file. 

3.  Choose whether or not the file contains latitude and longitude fields. (If it does, 

geocoding is done on the latitude and longitude rather than the address, even if an 
address is included in the CSV.) 

4.  Click Next. 

The next screen in the wizard opens. 

5.  Map the columns of the CSV to the POI fields or, if necessary, ignore a column. 

Note: As with data entry, required fields are shown with an asterisk. 

Choose the POI Type, Buffer (circumference of the POI circle area), E-mail 
Notification Delay, and Category. 
The next screen in the wizard opens. 

6.  Click Next. The CSV data is imported or, if errors were found, an error file is created. 
 

Exporting POIs 
In addition to the usual print/export function, you can export your configured POIs to Excel 

format. 

1.  On the Fleet Configuration screen, in the Points of Interest group, click Points of 
Interest, then click Export Spatial Data. 

A new screen opens. 

2.  Browse to the location where you want the file containing exported data created, enter 
a file name, and choose a file type. 

3.  Click Next. 
The next screen of the wizard opens. 

4.  Choose the POI types whose data you want to export and click Next. 

The next screen of the wizard opens. 
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5.  Choose the fields of data you want exported and click Next. 

You see a preview of the data to be exported. 

6.  Click Finish. The export file is created. 

 

Setting up Resources 
 

About Resources and Crews 
 

Why Use This Function? 

Without resources, tracking can refer only to assets, not the people responsible for those 
assets. If you want to know who did something, not just what was done, you need to 
configure resources. You also need to configure resources if you want to have the individuals 
responsible for assets receive e-mails when an event for their asset is triggered and/or when 
the asset is due for maintenance. Resources are integral to messaging features as well. 

It is possible to configure resources that are not tracked, but are only assigned to activities. 

This is particularly used when you are already tracking the assets that people are using. The 
only visible difference between these resources and tracked ones is that they do not appear 
alongside an asset in the Map Items tree of the Tracking screen. 

If several resources work together as a single entity, grouping them together into a crew 
means that activities can be sent to the crew as a whole rather than to a single resource. 

 

What is the Default Configuration? 

By default, no resources or crews are configured. 
 

What Do I Need to Understand About Resources? 

A resource is an individual (not necessarily a Fleet Complete user) who works for your 
organization and operates an asset. 

Although resources are assigned to assets, you have several choices for how to make that 
assignment. The asset configuration screen allows you to manually choose from the list of 
configured resources, but this fixed assignment is not advisable. It is more appropriate to 

have resources assigned to assets dynamically, through a PIN or driver ID Fob. This allows 
multiple resources to share responsibility for an asset. It also allows you to manage security 
by defining an Unauthenticated Resource rule that records an event when someone operates 
the vehicle without being authenticated through a driver ID Fob. The temporary association 
between asset and resource appears in the Tracking screen map as well as in the asset's 
configuration and in reports. 

Additional resources information can be captured: 

• the resource's code (e.g. driver number) and category 

• the resource's category (used for reporting) 

• a vehicle type 

• a home base (useful for monitoring and reporting on the resource's interaction with 
the home base, for example, to monitor for late departures from that base, or to 
record how often they return to the home base during working hours) 

• the hourly cost for the resource (used in reporting) 

• the maximum length of time the resource should travel between stops (for example, 
at POIs) — used for management reports 

• mobile contact information such as email address 

Resources can have an associated work schedule used for activity and reporting purposes. 

Resources are grouped by type for reporting and security profile purposes. 

What Do I Need to Understand about Crews? 

A crew is a group of resources (can be of different resource types) that is considered a single 
entity. A resource can be part of only one crew. The crew itself is assigned a resource type, 
allowing type-based reporting to include crews as well as individual resources. 
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Resources are associated with crews through the crew configuration, not from the resource 

configuration. 

One member of the crew is designated as the crew chief: when the chief logs in, the entire 
crew is assumed to be logged in and available for work. Each member of the crew is given the 
same status as the crew chief (for example, "on break"). If a crew member logs on 

independently, they are assumed to be working outside of the crew and their status is 
recorded separately. 

 

What Do I Need to Understand about Service Groups? 

Service groups are logical groupings of resources and crews, with a defined supervisor (a Fleet 
Complete user, not a resource). They are typically used to group resources based on 
geographical area. Service groups can be associated with an activity, and are also used for 

management reporting purposes. 

For Example 

You set up service groups to reflect geographical areas in which you provide service. You can 

then report on resource activities within those areas. 
 

Setting up Resource Types 

Note: Be sure you are familiar with the overall concepts of resources before proceeding. 

1.  On the Fleet Configuration screen, in the Resources group, click Types. 
A grid of existing resource types, indicating the number of resources assigned to each, 
appears. 

2.  Click Add. 

The Resource Type screen opens. 

3.  On the General tab, enter a Description (name) for the resource type. 

4.  On the Resource Assignments tab, check those resources to be assigned to this type. 

5.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the resource 
type and what those changes were (Audit tab). 

 

Setting up Crews 

Note: Be sure you are familiar with the overall concepts of resources before proceeding. 

1.  On the Fleet Configuration screen, in the Resources group, click Crews. 
A grid of existing crews, showing status, number of resources (crew members), and 
other information, appears. 

2.  Click Add. The Crew screen opens. 

 

3.  On the General tab, enter a Name for the crew. 

4.  Choose the crew's Type or add a placeholder. 

5.  Choose the POI that constitutes the Home Base for the crew. 
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Note: The crew's Work Status and Status Time shown here relates to the MDT 

functions and cannot be modified. 

6.  Enter the Hourly Cost for the crew (used in reporting). 

7.  On the Resource Assignments tab, check those resources to be assigned to this crew. 
(If resources are currently logged on, they will be logged off when the crew is saved.) 

8.  Designate one of the resources as the crew chief: select their name and click Set as 
Crew Chief. Only one resource can be the chief of any given crew (by default, the 

first member of the crew is set as the chief). 

9.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the crew and 
what those changes were (Audit tab). 

 

Setting up Resources: Overview 
Note: Be sure you are familiar with the overall concepts of resources before proceeding. 

1.  On the Fleet Configuration screen, in the Resources group, click Resources. 

A grid of existing resources, showing summary information about each, appears. 

2.  Click Add. 
The Resource screen opens. 

 
 

3.  On the General tab, enter the resource's Name. 

4.  Choose the resource's Type or add a placeholder. 

5.  Optionally, enter contact, license, and demographic information (including a photo) for 
the resource. 

6.  Complete any custom fields. 

7.  Optionally, enter the resource's start and end date of employment. 

8.  If using a Fob to authenticate resources, populate the Mobile ID field by reading the 

driver ID Fob. 

9.  If you will be using MDT messaging, enter the resource's PIN. Resources will use this 

PIN when logging in to their handheld or MDT device. 

10. If the resource uses a dispatch-only handheld, enter the handheld's phone number in 
the Dispatch Device field and choose, from the Communication Method list, either 
MDT or Handheld, depending on the nature of the handheld. 

11. Optionally, choose the resource's communication method. The method chosen will 
determine the destination for information related to activities for the resource. 

12. Choose the resource's work schedule. 
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Note: The resource’s Work Status shown here relates to MDT and cannot be 

modified. 

13. Optionally, enter license and insurance information for the resource. 

14. Complete the Additional Settings tab. 

15. Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the resource and 
what those changes were (Audit tab). 

 

Setting up Resources: Additional Settings 
1.  On the Additional Settings tab of the resource screen, enter additional information 

about the resource. 

Show Screen 

 
 

2.  Enter the Resource Code, used for reporting purposes. 

3.  Choose the resource Category from the built-in list (used for reporting purposes). 

4.  Choose which resource, if any, is the resource's managing resource. 

5.  Choose the Vehicle Type the resource drives. 

6.  Choose the Home Base of the resource. 

7.  Enter the Hourly Cost for the resource. 

8.  Specify the maximum number of hours the resource should travel between jobs (for 
example, you might want a resource to travel no more than 30 minutes between 
POIs). Used for reporting purposes. 

9.  Enter Additional Contact Information for the resource, such as mobile number or 
email. 

10. Click Save & Close. 
 

Setting up Service Groups 

Note: Be sure you are familiar with the overall concepts of resources before proceeding. 

1.  On the Fleet Configuration screen, in the Resources group, click Service Groups. 
A grid of existing service groups appears. 

2.  Click Add. 

The Service Group screen opens. 

3.  On the General tab, enter a Description for the service group. 

4.  Choose the service group's Supervisor (a system user). 
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5.  On the Resource/Crew Assignments tab, check those resources and crews to be 

assigned to this service group. 

6.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the service group 
and what those changes were (Audit tab). 

 

Using Driver ID Fobs with Fleet Complete 

If you will be using driver ID Fobs to authenticate resources: 

1.  Before you configure resources, install the appropriate software on a computer that 
has access to Fleet Complete. 

2.  Attach the appropriate reader to your computer via USB and make sure the necessary 

software drivers for the reader are installed. 

3.  Open the Resource screen and complete the basic fields. 

4.  Place a driver ID Fob in the reader and click the ellipsis (...) beside Mobile ID. The 

field is populated automatically with the driver ID Fob in the reader. 

5.  Continue setting up the resource. 

6.  Remove and label the Fob and give it to the driver. 

7.  Repeat for each driver. 
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WORKING WITH FLEET 
 

Viewing Time of Last Snapshot 
In the Assets grid, the time and date of the last snapshot of data for that asset is shown. 

 

Viewing Resource, Run, and Related Assets 
An asset's current resource, run, and related asset are shown in: 

• the Assets grid 

• the Tracking screen. 

 

Viewing Current Location of Asset 
An asset's current location is shown in: 

• the Assets grid 

• the Tracking screen. 

 

Viewing Work Status of Resources and Crews 
The resources grid shows the work status of each resource; the crews grid shows the work 
status of each crew and the time that status began. 
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WORKING WITH ACTIVITIES 
 

Background 
 

About Activities 
 

Why Use This Function? 

Use the Activities function to define simple activities (such as a service call) to be done at a 
specific location, assign them to a resource, and monitor their progress. 

 

What is the Default Configuration? 

The names of the available statuses for activities are configured by default: you can change 
these if you wish. 

 

What Do I Need to Understand About Activities? 

The information associated with an activity includes: 

• the POI at which the activity should take place 

• the activity number (system-assigned) 

• when the activity should start and by when it should be completed — this information 
helps flag activities that are late or almost late to start or finish 

• its status (see workflow below) 

• what resource/crew has been assigned the activity, if any 

• what service group is associated with the activity 

• notes and instructions about the activity (for example, describing the activity to be 
performed, such as "replace air conditioner unit") 

The workflow of an activity is as follows: 

1.  The activity is created: its status is Open. 

2.  The activity is assigned to a resource: its status is Dispatched. 

3.  The resource accepts or rejects the activity: the activity status is Accepted or 
Rejected. A rejected activity can be assigned to a different resource. 

4.  The resource completes the activity: the activity status is Completed. 

An Open activity is one which has no resource. This may be because a resource/crew has not 

yet been assigned to the activity, or because the previously assigned resource/crew has been 
removed from the activity. 

An activity can be cancelled at any stage before it is completed. 

Note Activities are sent to mobile devices, where resources can use their GPS to navigate to 
the location of the activity. 

 

Changing Activity Status Names 

1.  On the ribbon toolbar or main menu, click Activities > Template. 
The Activity Template Screen opens. 
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2.  Enter alternative names for any or all statuses. 

3.  Click Save & Close. 
You are informed that your changes will take effect only once you have logged off and 
on again. 

 

Creating Activities 

You can create activities from the: 

• Activity — Search screen 

• Activities Panel 

• Activity — Booking screen 
 

1.  Click Add or     or, on the Booking screen, right-click on the appropriate start 
date/time and choose Add Activity. 

The Activity screen opens. 

 

2.  If the activity is to take place at a POI, from the Locations field choose a POI. 

- or - 
If the activity is to take place at a location not configured as a POI, click the + beside 
the Locations field. 

3.  If you chose a POI, the POI name appears as the activity Name by default (you can 
override this) and the address details from the POI are filled in. 
- or - 

If you chose to specify a location, the fields on the left side of the panel are cleared. 

Enter a Name and complete the address fields and Location Notes field. 

4.  Optionally, enter information about the request (the Caller, Phone number, and 

Reference, such as service order number). 

5.  Specify when (both date and time) the activity should start and end. 

Note: If the start or end date is configured as a holiday when the company will be 
closed, an icon appears next to the date indicating the conflict with the holiday 

6.  Optionally, choose the Service Group responsible for the activity. Only 

resources/crews associated with the selected group can be assigned to the activity. 

7.  To assign this activity immediately, choose an Assigned Resource/Crew (an activity 
can only be dispatched to a resource whose work schedule overlaps with either the 
start or end date/time of the activity). The status changes to Dispatched. 

- or - 

To assign this activity later, from the Status list choose Open. 

8.  Optionally, enter Activity Instructions that provide guidance to the resource. 
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9.  Click Save & Close. 

The activity is assigned a system-generated number. 
 

Searching for Activities 
You can choose from two methods when searching for activities: basic and advanced search. 

Use basic search to search based on a single criterion. Basic search looks for an activity based 
on its number, reference, location (POI), or assigned resource/crew (enter all or part of the 
number or name). 

Use advanced search to search based on multiple criteria, including activity number, current 
status, or status within a date range. Multiple criteria are cumulative (this AND that AND the 
other). 

For Example 

To find all activities that have been created but not yet assigned, from the Status list choose 

Open, then click Search. 

To find all activities that were created in June this year, from the Date Type list choose 

Created, then set the From Date to June 1 and the To Date to June 30 of the current year, 
then click Search. 

To perform a search: 

1.  On the ribbon toolbar or main menu, click Activities > Search. 
The Activity — Search screen opens, show two tabs: Basic Search and Advanced 

Search 

 
 

 
 

2.  Choose the appropriate tab. 

3.  Enter the appropriate search criteria and click Search. 
The search results appear in the grid. 

You can work with the search results using the same functions as any grid, including deleting 
and printing/exporting. 

 

Editing Activities 

You can edit activities from any of the following: 

• Activity — Search screen 

• Activities Panel 

• Activity — Booking screen 

Editing an activity allows you to change any of its details, and is the only way to transfer 
responsibility for an activity once it has been dispatched to a resource/crew. 

 

Select an activity and click Edit or , double-click on the activity or, in the Booking screen, 
right-click and choose Edit Activity. The activity's properties screen opens. 
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You can then: 

• If necessary, change activity details on the General tab, including changing the 

resource assigned to the activity or removing the assigned resource/crew (the activity 
becomes Open). 

Note: The activity's location cannot be changed once the activity has been accepted. 

Note: The list of resources will reflect only those whose work schedule overlaps with the 
activity's start or end time/date. 

• View the activity's workflow history (Status History tab). 

• View notes (added by other users or by the resource) on the Notes tab. 

• Add notes about the activity. 

• See which users have made changes to the activity and what those changes were 
(Audit tab). 

 

Assigning Activities to Resources 

You can assign activities to resources when you add or edit an activity: choose an Assigned 

Resource/Crew and save the activity. 

You can also assign activities without opening them: 

1.  On the Activities panel, select an activity that has a status of Opened or Rejected (that 

is, has no assigned resource/crew). 

2.  From the Resource/Crew list, choose a resource (only logged-in resources are 
listed), then click Dispatch. 

The activity's status changes to Dispatched. 

Note: You cannot assign an activity to a resource if the resource's work schedule does not 
overlap with the activity's start or end time/date, or if the resource is not a member of the 
service group associated with the activity. 

Note: The activity is sent immediately unless the start date for the activity is not today's date, 
in which case the activity will not be sent to the resource until 60 minutes before the start 
time/date. 

If you want to transfer responsibility for an activity to another resource, you need to edit the 
activity and choose a new resource. Note that the status will remain Dispatched — it is 
assumed that the new resource has accepted the activity. 

 

Monitoring and Managing Activities 
 

Working with the Activities Panel 

Open the Tracking screen, then open the Activities panel. 

Show Example 
 

 

The panel shows activities for the current date or earlier. Activities are colour-coded by status. 

The flags beside the activity number indicate the timeliness of the activity: 

• a red flag indicates the activity is late in starting or finishing (the start or end 
date/time has passed without the activity being accepted) 

• a yellow flag indicates the activity is almost late in starting (the start date/time is 
within 20 minutes of the current time) 

• a blue flag indicates the activity is almost late in finishing (the end date/time is within 
20 minutes of the current time) 

To locate an activity on the map, select the activity and click Zoom To. 
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To change which resource is assigned to an activity, select the activity (of any status but 

"Accepted") and choose from the Resource/Crew list. The list shows only resources/crews 
who are available (logged in or on break). 

You can also use this screen to edit or add activities and to sort information as with other 
grids. 

 

Working with the Booking Screen 
 

Opening the Booking Screen 

On the ribbon toolbar or main menu, click Activities > Booking. 
The Activity — Booking screen opens. 

 

Components of the Booking Screen 

The Booking Screen is made up of: 

• a list of resources who are logged in or on break (on the left) 

• a view showing day, work week, week, month, or timeline views (in the middle) 

• a calendar of the current and next two months (on the right), with holidays marked 
 

Determining What Activities are Shown 

By default the Booking Screen shows activities for all resources: check the checkbox to select 
those resources whose activities should be shown, clear the checkbox for those whose 
activities should be hidden (or click Select All or Un-Select All). 

By default the Booking Screen shows activities with a status of Open, Dispatched, Rejected, or 

Accepted: to change this, use the Filter by Status list and check the status(es) to show. 
 

Working with the Calendar 

The Resources and Calendar sections operate as panels. 

The Booking screen operates in a way similar to Microsoft Outlook and other task management 
programs. 

The calendar view shows the activities assigned to the selected resources during the selected 

time period. Activities are colour-coded by status. Holidays configured for the company are 

shown: a red cell indicates a day on which the company is closed. 

Double-click on any activity to open and edit it. In the Month view, if not all the activities on a 

given day can be displayed, a   appears in the cell: click on it to open the day view for that 
day. 

Note: You cannot drag an activity to a new location on the calendar to change its start or end 

time/date: open the activity and edit it to change times and dates. 

You can right-click on any cell in any view to: 

• add an activity 

• go to today's date or a selected date 

• change the calendar view 

• group the data by resource 

• group the data by date 
 

Activity Colour Coding 

On both the Activities panel and the Booking screen, activities are colour-coded by status: 

• green indicates an Accepted activity 

• blue indicates an Open activity 

• purple indicates a Dispatched activity 

• red indicates a Rejected activity 
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USING MAINTENANCE 
 

About Maintenance 
 

Why Use This Function? 

The Maintenance function allows you to schedule, record, and manage the service 
requirements of your assets. The service items most commonly needed to meet service 

requirements are automatically created. In addition, relevant resources and other contacts 
(such as a mechanic) can be automatically e-mailed a reminder about the need for 
maintenance. 

For Example Your delivery vehicles need oil changes every 5,000 kilometres. You want both 
resources and service managers reminded when this service is due. 
Some vehicles require annual safety inspections. You want your safety officer notified when 

this service is due. 
 

What Do I Need to Understand About Maintenance? 
Each time maintenance is required for an asset, a maintenance item is created (using a nightly 

job). Typically, items are created based on a service schedule (for example, oil changes are 
scheduled every 5000 kilometers/3000 miles) for each asset assigned to that service schedule, 
based on the asset's operating hours (length of time in operation) and odometer reading. 

Service items can also be manually created for a specific asset. Service items can be either 
Open (not yet completed), Completed, or Disregarded. Service items cannot be deleted. 

For Example Assets X, Y, and Z are scheduled to have oil changes every 5000 kilometres. 

When asset X has travelled 5000 kilometres, a service item is automatically created for that 
asset. When the other assets reach that distance travelled, service items are created for each 
of them as well. The next time those assets have travelled 5000 kilometres, another service 
item is created for each. 

Designated individuals can receive reminder e-mail messages about service needs. The e-mail 

includes the name of the asset and the type of service required. 

Maintenance users open or create service items and use them to record completed service, or 
to indicate that service was not done. 

 

What Do I Need to Understand About Service Schedules? 

Service schedules determine how often maintenance items are created. 

Service schedules fall into the following categories: 

• None — occurs only once 

• Annual Date — occurs routinely, every year (specify the month and date on which the 
service is required) 

• Recurrence Date — occurs routinely, every x months or weeks 

• Fixed Odometer/Operating Hours — occurs just once, when the asset reaches a 
specific number of operating hours or odometer reading 

• Rolling Odometer/Operating Hours — occurs routinely, whenever the asset reaches a 

specific number of operating hours or Odometer reading 

• Fixed Date — occurs just once, on a specific date (specify exact date) 

• Recurrence Date or Rolling Odometer/Operating Hours — occurs every x km/mi/hour 

OR every x days/months (whichever comes first) 
 

What is the Default Configuration? 
By default, a "non-scheduled" maintenance category and schedule are provided: these cannot 

be modified or deleted. Non-scheduled maintenance is used for unplanned maintenance such 
as vehicle repairs following an accident. As a result, it has a "None" schedule and is not 
assigned to any asset. 
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How is Maintenance Configured? 

Configuring maintenance involves: 

• if necessary, entering accurate vehicle information for the assets to which maintenance 
will apply (this is normally done automatically by Fleet Complete) 

• setting up service categories that group related service schedules together (service 
categories might include "calibration", "cleaning", "lubrication", or "warranty") 

• setting up service schedules that specify how often (based on time, operating hours, 
and/or odometer reading) the service needs to be performed, the assets that require such 
service, and who to notify via e-mail about the service 

 

Setting up Maintenance 
 

Adding Vehicle Information 

Note: Be sure you are familiar with the overall concepts of the Maintenance function before 

proceeding. 

1.  On the Fleet Configuration screen, in the Maintenance group, click Vehicle 

Information. 

A grid of the assets with in-vehicle devices appears. 

2.  Select the asset to which you want to add maintenance-specific vehicle information 
and click Edit. 

3.  Optionally, change the Description (name) of the asset. (Note that your changes will 

affect the asset's configuration, with the name change seen by all users.) 

4.  Optionally, enter the License Plate, VIN, and Year of the asset. 

5.  Specify the Operating Hours and/or current Odometer reading of this asset. These 

values act as the starting point for calculating when the scheduled maintenance, if 
any, is required. 

6.  Enter the Make and Model of the vehicle. Depending on the asset's ECM 

configuration, some or all of these fields may be required. 

7.  If using ECM, choose an EMC Type. 
The Odometer and Fuel Economy reading will appear (this is updated regularly), as 
well as any ECM alerts (a specialized alert transmitted from the ECM device) received 

in the past 24 hours for this asset. 
 

Setting up Service Categories 
Note: Be sure you are familiar with the overall concepts of the Maintenance function before 
proceeding. 

1.  On the Fleet Configuration screen, in the Maintenance group, click Service 

Categories. 

A grid of existing service categories, showing the number of service schedules 

configured for each category, appears. 

2.  Click Add. 

The Maintenance Category screen opens. 

3.  Enter a Description (name) for the service category. 

4.  Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the service 
categories and what those changes were (Audit tab). 
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Setting up Maintenance Service Schedules 
Note: Be sure you are familiar with the overall concepts of the Maintenance function before 
proceeding. 

1.  On the Fleet Configuration screen, in the Maintenance group, click Service 
Schedules. 

A grid of existing service schedules, showing their type and their category, appears. 

2.  Click Add and choose the type of maintenance schedule to be created. 

3.  The Maintenance Service Schedule screen opens. The fields on the screen vary 
depending on the type of schedule chosen. 

4.  Enter a Description (name) for the service schedule. 

5.  Choose a service Category or add a placeholder. 

6.  Choose a Schedule Type and define the recurrence (varies depending on the type 
chosen). 

7.  Set up the recurrence timeline. 

8.  To e-mail a reminder to the resource/crew associated with the assets assigned to this 
service schedule, reminding them about the maintenance requirement, check E-mail 
Resource/Crew. 

9.  To e-mail a reminder to someone else (perhaps a technician or mechanic) about the 
maintenance requirement, check E-mail Recipient(s), and enter the appropriate e- 
mail addresses. 

10. Specify the Language of the e-mail messages. 

11. Specify how much in advance of the due date for the service schedule the reminder e- 
mails should be sent. 

12. To assign assets to this service schedule, use the Asset Assignments tab. Depending 
on the Schedule Type chosen, the Asset Assignment tab may allow you to enter 
when the next scheduled service is required. To enter the necessary information, first 
check the asset, then click in the appropriate column. 

 

If you chose this 
Schedule Type... 

You can enter... 

 

Recurrence Date the next date on which the maintenance should be 
performed 

 

Recurrence Date or Rolling 
Odometer/Operating Hours 

 

the next Odometer reading or operating hours the 
asset needs to reach before the maintenance will 
be required, and/or the next date on which the 
maintenance should be performed 

 

Rolling Odometer/Operating 
Hours 

 

the next Odometer reading or operating hours the 
asset needs to reach before the maintenance will 
be required 

 

13. Click in the appropriate column of a checked asset and enter the appropriate values. 

14. Click Save & Close. 

Note: You can also use this screen to see which users have made changes to the service 

schedule and what those changes were (Audit tab). 
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Working with Maintenance 
 

About the Maintenance Screen 
Once maintenance is configured, service items are created automatically when an asset 
requires any type of service. You can also add service items if necessary. 

The Maintenance screen shows active service items in a grid. For each item, you see the name 

of the asset, the type of service, the status of the service item, and the date the service is 
due. 

 

Opening the Maintenance Screen 

To view, edit, and add maintenance items: 

1.  On the ribbon toolbar or main menu, click Fleet > Maintenance. 

2.  The Maintenance screen opens, showing active service items in a grid. 
 

Adding Maintenance Items 
If unscheduled maintenance needs to be performed for an asset, you can add a service item to 
track that item. 

1.  From the Maintenance screen, click Add. 
The Maintenance Service Item screen opens. 

 

 
 

2.  Choose the Asset that requires the maintenance. 

3.  Choose a Service Schedule to be used to schedule this service, or add a placeholder. 

4.  Choose Open or Completed from the Status list. 

5.  Enter the Odometer reading and/or Operating Hours (hours in operation) for the 
asset at the time the maintenance was performed. This will be used to calculate the 
next service item needed for the asset, if applicable. 

6.  Indicate the Service Date (when the service was performed) and Cost. These will be 

used in reporting. 

7.  Add any explanatory comments. 

8.  Click Save & Close. 

Note: Service items remain in Fleet Complete indefinitely. Marking an item as completed or 

disregarded will not remove it from display. 

You also use this screen to record maintenance performed. 
 

Recording Maintenance Performed 
As maintenance is performed, or if it is to be disregarded for this instance (for example, the 
Odometer reading is incorrect and the vehicle does not require the scheduled maintenance 
yet), you should record its status. 

1.  From the Maintenance screen, double-click on a service item to open it. 

The Maintenance Service Item screen opens. 
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2.  Choose Completed from the Status list. 

3.  Enter the Odometer reading and/or number of Operating Hours for the asset at the 

time the maintenance was performed. This will be used to calculate the next service 
item needed for the asset. 

4.  Indicate the Service Date (when the service was performed) and Cost. These will be 
used in reporting. 

5.  Add any explanatory comments. 

6.  Click Save & Close. 

Note: Items remain in Fleet Complete indefinitely. Marking an item as completed or 

disregarded will not remove it from display. Maintenance history can be viewed on the 
Maintenance report. 

You can also use this screen to: 

• view the changes to this item's status, who changed the status, and when (History 
tab) 

• see which users made changes to the maintenance service item and what those 
changes were (Audit tab). 
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WORKING WITH MDT MESSAGING 
 

About MDT Messaging in Fleet Complete 
If your organization uses vehicle devices that have an MDT connected for two-way 

communication, that communication can be streamlined and managed through Fleet 
Complete. 

Note: This function must be enabled by Complete Innovations for your organization's account. 

Users can only view MDT messages if their user account is set up to show them. 

Dispatchers can send free-form messages and drivers can send a canned message or reply. 
Canned messages and replies are organized into groups (for example, supervisors, 
technicians). All assets that have MDT capability are associated with a canned message and 
reply group and the messages and replies in that group are automatically available to those 
assets. In addition, when you send a message to a driver you can specify the choice of replies 

available to them when responding to that message. 

MDT messages sent to and received from assets appear in a Messages panel on the bottom of 
the Tracking screen. 

 

About the Messaging Panel 
MDT messages sent to and received from resources appear as pop-up messages as well as in 
a Messaging panel at the bottom of the Tracking screen. A separate tab is opened for each 
driver with whom you are communicating: the tab shows the thread of communication with 

that driver, including information on when messages were received or sent. 

Note: You only see the Messaging panel if your user account is set up to show MDT messages, 
and only for the assets in your security profile. 

The Messaging panel lists either all available drivers (All Online) or just those with whom you 
are communicating (In Live Sessions). Whether drivers are displayed with resource name or 
asset name first depends on your map options. To locate a driver in a lengthy list, enter their 

name in the search box at the top right of the panel and press Enter or click . 

Use the panel to send messages to resources or reply to messages from resources. 

 

Configuring MDT Messaging 
Once MDT messaging is enabled for your organization, you need to do the following to 
implement it: 

1.  Set up message groups and messages. 

2.  Enable MDT for assets and choose a canned messages and canned reply group for 
each asset. 

3.  Enable MDT messaging for the user accounts of those who will use this function. 

 

Setting up Canned Messages and Replies for MDT 

Messaging 
1.  On the Fleet Configuration screen, in the Assets area, click Canned Messages or 

Canned Replies. 

A grid of existing messages or replies appears. 

2.  To add a message/reply to an existing group, select a message for that group and 
click Edit. 
- or - 

Click Add, then enter the name of the new group. 

3.  To add a message/reply to the group, click   and enter the text of the Message or 

Reply. 
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To remove a message/reply from the group, select it and click . 

To change the order of messages/replies in the group, use the     and     buttons. 

4.  Click Save & Close. 

 

Sending an MDT Message from the Tracking Screen 
Note: You can only send messages to assets to which your security profile granted you access. 

If an asset has an MDT device, and is associated with a resource, you can send a message to 

its driver from the Tracking screen. 

1.  On the Tracking screen, right-click on an asset in the map or Map Items panel and 
choose Send Message. 
The Message screen opens. 

 

 
 

2.  Enter a Message. 

Note: Special characters within a message may not be transmitted properly. Your 
message as seen by the resource is shown in the Messaging panel. 

3.  Optionally, check the canned replies that should be available to the driver when 
replying to the message. The list reflects the canned replies configured for the reply 

group to which the asset was assigned. The order in which you check replies is the 
order in which they will appear to the driver. 

4.  Click Send & Close. 

5.  Your message appears on the Messaging panel on the bottom of the Tracking screen. 

Note: Other users will not be able to see your messages or the replies to them. 

 

Sending a POI Stop 
If an asset has an MDT device, and is associated with a resource, you can send the address 
information for a POI as a stop to that resource. This communication does not appear on the 
Messaging panel. 

1.  On the Tracking screen, right-click on a POI in the map or Map Items panel and 
choose Send to Device. 
- or - 

Right-click on any location in the map and choose Send this Location as a Stop. 

2.  When prompted, choose from the available assets, then click Send. 

 

Sending an MDT Message from the Messaging Panel 
By default, resources can respond to messages sent from the Tracking screen or Messaging 
panel using any of the replies in their canned replies group. However, you can choose to limit 
the drivers' responses to just some of those replies. 

To send a message to one or more drivers without limiting responses: 

1.  Select the resource (one, several, or all) in the Messaging panel. 

2.  Enter the message in the lower portion of the panel. 
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3.  Press Enter. 

Tabs for each of the resources to which you sent the message open. You can use these 
tabs to view replies and send additional messages. 

To send a message to a single resource and, optionally, limit responses: 

1.  If the Messaging panel does not already show a tab for the resource, double-click on 
the resource name on the main tab of the panel to open a tab for that resource. 

2.  To send the message without restricted responses, enter the message for the resource 
in the lower portion of their tab and press Enter. 
To restrict the available replies to only some of those in the canned replies group 

associated with the resource's asset, click    (in the bottom right corner of the tab) 

and check each allowed reply, then click Send. 
 

 
 

Replying to an MDT Message 
 

When a message has been received from a driver, an appears on their tab in the 
Messaging panel. 

To reply: 

1.  Click the appropriate tab. 

2.  Select the message you are replying to. 

3.  Enter the reply in the lower portion of the panel. 

4.  Press Enter. 

 

Messages Report 
 

What the Report Shows 
For each MDT-enabled asset, shows: 

• date and content of message sent 

• time the message was received, read, and sent 

• content of reply and resource who sent it 

• number of canned messages that have been generated 

• resource/crew engaged in the communication 
 

How to Generate Report 

1.  On the Reports screen, click Report > Fleet > Messages. 

2.  From the top list, choose whether you want to report on individual Assets, whole 
Asset Types, individual Resources/Crews or whole Resource Types. 

3.  Select one or more items to be included in the report. 

4.  Choose the date range for the report. 

5.  Click Get Data. The report appears in a grid on the right. 
 

If necessary, you can click Cancel to stop the report generation process. This is useful if you 

realize you need to refine your report parameters before the report finishes generating. 
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WORKING WITH OPERATIONS REPORTS 
 

Background 
 

About the Operations Reports Function 
 

Why Use This Function? 

Reports give you a detailed view of all Fleet Complete data, whether captured from GPS, 
sensors, events, or interactions with POIs. Reports can be used for a wide variety of purposes 
that offer your organization additional value, such as: 

• validating timesheets or receipts 

• substantiating claims for government rebates 

• demonstrating service to customers for enhanced customer service 

• identifying patterns of behaviour that affect fuel economy 

• identifying possible inefficiencies in scheduling and dispatching 

• identifying potentially inappropriate driver behaviours 

It is important to produce reports regularly: data in your Fleet Complete system is retained for 
a limited period of time (typically, three months). Reports can be scheduled and the report 
output e-mailed to any number of individuals automatically, providing an archive record of 

your important data. 
 

What is the Default Configuration? 

A full set of Operations reports is provided by default. Custom reports may be purchased from 

Complete Innovations. 
 

What Do I Need to Understand About Operations Reporting? 

Report functions include: 

• the reports themselves (Fleet reports and custom reports provided by Complete 

Innovations) 

• the Reports Dashboard, a customizable view of important graphical data 

• reports schedules used to automatically produce and distribute Operations reports 

Report data is shown in both imperial and metric measurements: you can hide the columns 
that contain measurement information you do not use. 

Report information shows values recorded in custom fields: you may want to hide this data if 
it is not relevant for reporting purposes. 

We Recommend As a best practice, you should choose the reports that meet your specific 
needs, generate them manually so you can determine the best layout and criteria for your 
purposes, then create a schedule. If a report can provide data for several individuals (for 
example, for both your payroll and operations departments), create more than one schedule 
for the same report, customizing the contents and layout as appropriate for each recipient. 
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Opening the Operations Reports Screen 

On the ribbon toolbar or main menu, click Reports > Operations. 

The Reports — Operations screen opens. 
 

 
 

About the Operations Reports Screen 

The Reports — Operations screen is made up of the following elements: 

• a Report menu from which you can choose a type of report and then a report name 
(for example, Report > Fleet > Speeding) 

• a Report Parameters panel used to choose the appropriate parameters for the selected 
report 

Note: Once you have set the parameters for one report, Fleet Complete applies relevant 
parameters to all subsequent reports until you log off. 

• the output of the selected report: you can customize the report's layout to suit your 
needs, show any report data point on the map, or (for some reports) use a Visualizer 

Note: To generate a report once you have specified the parameters, click Get Data or press 

F5 (as long as the parameters panel is the active one). 
 

About Scheduling Operations Reports 
 

Why Use This Function? 

Once you have established which reports are most useful to your organization, scheduling 
them ensures that those reports are generated automatically and e-mailed to the appropriate 
contact. The same report can be scheduled in different ways for different purposes, such as for 
different recipients or to focus on different groups of information. 

For Example Your payroll staff use the Activity report to reconcile driver timesheets, while 
management uses it to monitor driver behaviour. You can create two schedules for the report, 
one that generates the report weekly (for payroll) and one that generates it daily (for 

management). For payroll purposes, you set up the report layout so that the report shows 
only the asset's activities, the amount of time they took, and the start and end location/POI. 
For management, you set up the report layout so it also includes total distance and speed. 

Once you have created a report schedule, you can run it manually whenever necessary 
 

What is the Default Configuration? 

No reports are scheduled by default. 
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What Do I Need to Understand About Report Scheduling? 

Report schedules specify: 

• the type of report (e.g. Speeding) to be generated 

• the report's parameters (for example, the asset types to be included in the report) 

• how much data is to be included in the report 

• how frequently the report schedule is to run, at what time it is to run, and who should 
get the results 

• the report layout (what columns of data are shown, how data is ordered, and how data 
is grouped and organized) 

• the report format (PDF, Excel, etc.) 

Note that scheduled reports will be deleted if the security profile of the user who scheduled 
them is deleted. 

We Recommend Before you schedule reports, experiment with manually generated report 

results to determine the most useful output for the report recipient. Only those columns 

shown in the scheduled report's layout will be available to the report recipient. 

Scheduled report results are e-mailed in zip files. Recipients will need access to an "unzip" 

application and to the application appropriate for the report's format, such as Acrobat Reader 
or Excel, to view the reports. 

 

Available Operations Reports 
 

Fleet Reports 
 

Use this 
report... 

If you want to see... 

 

Activity the details of asset activities (for example, to compare the report results 
with submitted worksheets, or for general resource management) 

 

Asset 
Temperature 

 

that the temperature of the asset remained appropriate throughout its 

journey (for example, when transporting medical supplies or livestock) 
 

Congregation when more than one asset was at the same location at the same time 
(for example, to identify potential duplicate efforts such as two 
individuals being at the same supplier; to identify possible inappropriate 
gatherings of multiple individuals) 

 

Curfew if assets were at a POI outside the POI's specified working hours (for 

example, to ensure assets are arriving at supplier offices only when 
those offices are open) 

 

Distance the distance an asset travelled within a province/state on a particular 
day, including distance driven on private roads 

 

DTC DTC details for assets with an ECM device 
 

Event when an event was triggered (for example, when an asset experienced 

harsh braking or exceeded the speed limit by 15%) 
 

Fleet 
Performance 

 

a measurement of asset performance based on events (total number of 
events per asset and an overall weighted score using event rankings) 

 

Idle how often and for how long assets were idle 
 

Input details of sensors (for example, when an asset's snowplow was up or 
down at a customer location) 

 

Last Position last snapshot time and location of assets 
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Use this 
report... 

If you want to see... 

 

Maintenance the full history of maintenance items (for example, what maintenance 
has been performed on your delivery vans in the past six months so 
service bills can be reconciled) 

 

Messages two-way communication exchanges with MDT-enabled assets/resources 
 

Non-Transmit which assets were offline (for example, to identify any recurring 
problems with devices) 

 

POI interactions that assets had with specific categories of POIs (for 
example, to see when assets were at client sites during their work 
schedule) 

 

Position every snapshot taken for assets during specified times 
 

PTO Usage details of a PTO's usage 
 

Speeding the speed an asset travelled, or the speed in excess of the posted speed 
limit an asset travelled 

if a rule was defined for this situation, you can also use the Event report 
for this purpose 

 

Stop when an asset was stopped for a specific length of time (for example, to 
see if assets remain at warehouses longer than desired) — for assets 
with valid ignition states 

 

Time Card work, break, and login/logout times for resources 
 

Trip details of an asset's trips (for example, how long it took the asset to get 
to a specific address), based on time between ignition on and ignition off 

 

Unknown 
Movement 

 

when there is questionable activity of an asset 

 

Unvisited POIs the last time a POI was visited 
 

Who Was 
There 

 

what asset was at a particular location at a particular time 

 

Work Schedule when first ignition on and last ignition off took place in relation to assets' 
current work schedule 
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Operations Report Functions 
 

Setting System Options 
1.  On the ribbon toolbar or main menu, click System > Options. 

The System Options screen opens. 

 
 

2.  Choose your company's Year End and press Tab: the quarterly dates are completed 
automatically. 

3.  Enter the distance to be used when generating Management reports: for example, if 
you enter a Distance Break of 200 km, the report will calculate the average number 

of events that occurred each 200 km and use that calculation to determine averages 
shown in some reports. 

4.  Enter values for each of the three Speed Windows shown on the dashboard. 

5.  Enter the Event Rank for each of the possible events (Speeding, Racing, Idle, 

Braking, Acceleration, Cornering, Open Maintenance Item) to determine the weight 
each has in relevant Management reports, the Fleet Performance report, and on the 
Dashboard. Performance will be calculated by multiplying the value associated with a 

parameter by the number of event occurrences for the asset. For example, if the open 
maintenance items parameter is set to 3, an asset with 5 outstanding maintenance 
items will have a score of 15. 

6.  Define, in more granular way, when an asset is considered to be "working". This is 

used for calculations in Management reports. For example, if a technician gets paid for 
each service call they make, when they are stopped at any client site, they are 
considered to be working. 

7.  Click Save & Close. 

Note: Management reports are a beta feature. 
 

Scheduling Operations Reports 

Be sure you are familiar with the overall concepts of report scheduling before proceeding. 

1.  On the ribbon toolbar or main menu, click Reports > Report Schedules. The Reports 
Schedules screen opens, showing the schedules you have configured. 

2.  Click Add, choose a type of report (Fleet), then choose a report. (For example, Add> 

Fleet > Speeding.) 

The Report Schedule screen opens, showing the parameters available for that specific 
report, the fields to be used to define the report schedule, and a layout area. 
Show Example 
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3.  Choose the parameters as you would for a manually-produced report. 

Note: The report period is not available as a parameter, since the report's period is 
determined by the schedule. 

4.  Enter a Description (name) for the report. 

5.  Set how frequently you want the report to be generated (every day, every weekday, 
or only on a specific day each week). 

6.  Enter the e-mail addresses of the report recipients. 

7.  Choose the Export Format appropriate for the data and recipient. 

Note: Report outputs of all formats will be e-mailed in a zip file. 

8.  Choose the reporting period: 
 

This 
period... 

Includes data from... 

 

current date midnight of the current day to the time when the report is 
scheduled to run 

 

current week midnight of Sunday of the current week to the time and day when 
the report is scheduled to run 

 

previous full 
day 

 

previous day 

 

previous full 
week 

 

Sunday midnight to Saturday 23:59 of previous week 

 

previous 7 
days 

 

previous 7 days 

 

last XX hours the last XX hours, regardless of day 
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For Example A report is scheduled to run at 2 p.m. on Wednesday, January 20. 

 
 
 
 
 
 
 
 
 
 

9.  Choose the Time (and time zone) when the report should run. If generating reports 
for use by clients who are in other time zones, be sure to set the time zone to that of 
the client. This ensures that reports are delivered in accordance to the client's working 

time. 

10. Choose the Language to be used for the report output and the e-mail body. 

11. Use the Layout section to set up the report output as you want it to appear to the 
recipient(s). 

12. Click Save & Close. 

You can also use this screen to see: 

• The history (when the schedule ran and its results) of the report schedule. 

• Which users made changes to the report schedule and what those changes 
were (Audit tab). 

 

Suspending and Releasing Report Schedules 

Be sure you are familiar with the overall concepts of report scheduling before proceeding. 

1.  On the ribbon toolbar or main menu, click Reports > Report Schedules. The Reports 
Schedules screen opens, showing the schedules you have configured. 

2.  Open a report schedule by double-clicking on it, or select it and click Edit. 

The Report Schedule screen opens. 

3.  To suspend the report schedule, check Suspended. 

To release a suspended report schedule, clear Suspended. 

4.  Click Save & Close. 
 

Running Scheduled Reports on Demand 
Be sure you are familiar with the overall concepts of report scheduling before proceeding. 

Reports produced using this feature will use the parameters (recipient, report period, report 
format, etc.) configured for the scheduled report. 

1.  On the ribbon toolbar or main menu, click Reports > Report Schedules. The Reports 

Schedules screen opens, showing the schedules you have configured. 

2.  Select a report schedule and click Run Now. 

3.  The report runs immediately. 

Note: The report will continue to run at its normal scheduled time. 
 

Using the Reports Dashboard 

On the ribbon toolbar or main menu, click Reports > Dashboard. 

The Report Dashboard shows real-time graphical data that can be useful to monitor. You can 
control which types of data appear and how much data is shown. 

By default: 

• The top 10 items are shown, although you can choose a different number from the 
Top list to show more (maximum of 25) or fewer items. 
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• Data for today (the current 24 hours) is shown, although you can choose to show 

historic data (up to the previous full month) by choosing from the Period list. Only 
data gathered during the asset's work schedule is shown. 

• Information is reported by asset (to report by resource, click Options, then choose 
Resource from the Report On list). 

You can configure the Report Dashboard to show just the information that most interests you. 
Available information includes: 

• High Speed Incident Counts 

• Speed Windows (maximum speed per window set in system options) 

• Fleet Performance 

• Distance Travelled 

• Moving Time 

• Idle Duration 

• PTO Time 

• Least Fuel Efficient 

• POI Visits 

To rearrange panels, drag and drop them to the appropriate locations on the dashboard. 

To show different types of information: 

1.  Right-click on a graph header (not the data area) on the Dashboard and choose 
Customize layout. The Customization screen opens. 

2.  Drag panels of the Dashboard to the Customization screen to remove them from the 

Dashboard. 
Drag panels from the Customization screen to the position where you want them to 
appear on the Dashboard. 

To choose the unit of measurement for the display, click Options, then choose Metric or 

Imperial. 

To set the frequency with which the display automatically refreshes, click Options, then enter 

a value (between 1 and 60 minutes). By default the display does not automatically refresh, 

although you can manually refresh it by clicking . 
 

Using the Report Visualizers 
The Input, Position, and PTO Usage reports each include a Visualizer that shows the full report 
output on a map for up to 10 assets. 

To use a Visualizer, from the report output click Visualizers and choose the appropriate 
Visualizer. 

For the Input report, the Visualizer shows a map with a flag representing each location where 
the input status of the selected asset(s) changed. 

For the Position report, the Visualizer shows the travel of each selected asset during the 
reporting interval. If the report includes multiple days, each day's data is shown with the same 
colour. 

For the PTO Usage report, the Visualizer shows where the sensor had a state change during 
the reporting period, what the change was, and its time and duration. 

The Visualizers use the regular map controls. 

Use the checkboxes to show data for any or all of the selected assets. 

To show POIs on the map display, click Show POI. 

To show custom layers on the map display, click Custom Layers. 

To print the Visualizer output, click Print. 
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Viewing Report Data on a Map 

Once you have generated a report, select any row of the report input and click Show on Map 
 

or double-click on any row. A map window, showing the selected data point as a pin , 
opens. This window uses the regular map controls. For Input and PTO Usage reports, both 
start and end locations are also flagged. For the PTO Usage report, all points between the start 

and end locations have a red circle with a direction arrow (indicating the direction of the 
snapshot), where a direction can be determined. 

Note: This feature is not available for all reports. 
 

Working with Report Output 

Report output appears in a grid. You can work with this grid as with the other grids in Fleet 
Complete. Some of the most useful grid functions for report purposes are outlined here. These 
techniques can be used for both manually generated and scheduled reports. The format for a 
manually generated report does not apply to the scheduled version of that report. 

Once you have set up the report output for a specific report (manually generated or 
scheduled), your choices will be retained and used any time the report is generated again in 
the same manner. 

 

Grouping Data 

For many reports, you will find it useful to group the output by asset type and asset. For 
example, an Activity report generated for multiple assets shows a row for each asset activity 
performed by each asset, which can make the report quite lengthy. To make it easier to view 
the report, you can group by asset type and asset: drag those columns to the "group by" 
header. 

Show Results 

 
 

Filtering Data 

For all reports, you can focus the view by filtering data: click the     in the column header 

and choose the item you want to filter by. For example, you can use this function to show just 
specific asset activities in the Activity report. 

Show Results 

 

Because the grid for scheduled reports does not show any data (data is filled in when the 

report is generated), the filter list is more limited in the report schedule screen. However, you 

can click the     and choose (Custom) to create a custom filter. 
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Hiding Columns 

Some columns may not be relevant for your reporting purposes and can be hidden by right- 
clicking and choosing Remove This Column. Typical uses for this are: 

• to hide the column showing units of measurement (for example, miles, mph) not relevant 
for your organization 

• to hide columns made redundant by your reporting parameter choices (for example, if 
you select a category when running the POI report) 

 

Fleet Reports 
 

Activity Report 
 

What the Report Shows 

For each selected asset, shows the asset's activity information during the reporting interval, 

including: 

• name of the asset's activity, when it started and ended, and how long it lasted 

• amount of time the asset was idle or moving while performing the activity 

• asset's average and maximum speed while performing the activity 

• total distance the asset travelled during the activity 

• start and end location (address) of the activity 

• start and end POI (if any) of the activity — to report specifically on POI interaction, 
use the POI Report 

• start and end LSD (if any) of the activity 

• latitude and longitude of the start of the activity 

• whether the activity occurred during the asset's work schedule 

• whether the asset's GPS was valid at the time of the activity 

• run, resource/crew, and related asset to which the asset was assigned during the 
activity 

• values of any custom fields for the asset at the time of the activity 
 

How to Generate the Report 

1.  On the Reports — Operations screen, click Report > Fleet > Activity. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  By default, the report includes only ignition on/off. To include data for inputs, check 
Include Input States. 

7.  Choose the Minimum Duration an activity needed to last in order for it to be included 
in the report. 

We Recommend Choose a duration that will ensure only meaningful activities are 
captured, for example, those that lasted longer than two minutes. Note that doing this 
will not filter out ignition on/off states, since those are always immediate. 

8.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 
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Asset Temperature Report 

This report requires the asset to have a temperature sensor. 
 

What the Report Shows 

For each selected asset, shows the reading, during each snapshot throughout the reporting 
period, of each temperature sensor associated with the asset. 

 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Asset Temperature. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date and time range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 

schedule of the asset(s), or just data collected outside the work schedule of the 

asset(s). 

6.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Congregation Report 
 

What the Report Shows 

For any location where more than one asset was in close proximity to other assets during the 
reporting period (maximum 7 days), shows: 

• number of assets within the buffer zone around the location 

• start, end, and total time more than one asset was at the location at the same time 

• identifying information about the location (latitude, longitude, address, and POI, if 
any) 

The details of each row show: 

• which assets were present at that location (and their type) 

• start, end, and total time each asset was at the location 

• run, resource/crew, and related asset to which the asset was assigned at the time 

• values of any custom fields for the asset 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Congregation. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select at least two assets (or asset types) to be included in the report. 

We Recommend Choose a limited number of assets to speed up report generation. 

4.  Choose the date range for the report (no more than 7 days). 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Choose the size of the Buffer around the location: this identifies the "congregation" 
area. 

We Recommend Use a buffer appropriate for the environment. For example, in a 

dense urban environment, too large a buffer might result in assets that were in 
different locations for different purposes being considered "congregated" at the same 
location. 

7.  Click Get Data. The report appears in a grid on the right. 
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If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 

Note: To see report results for a line item on the map, click Show on Map. 
 

Curfew Report 
 

What the Report Shows 

For the interaction of each selected asset and any POI, outside the POI's working hours and 
during the reporting period, shows: 

• name of the POI where the asset was during the reporting period 

• time at which the interaction occurred — if the curfew violation was "arrived late", this 
is the time/date the asset arrived at the POI; if "departed early", this is the time/date 
the asset left the POI 

• "curfew time" for the POI — if the curfew violation was "arrived late", this is the 

time/date the POI was open; if "departed early", this is the time/date the POI was 
closed (based on the POI's working hours) 

• type of curfew violation ("arrived late" or "departed early") 

• run, resource/crew, and related asset to which the asset was assigned during 
reporting period 

 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Curfew. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Enter the length of the Grace Period granted to assets in determining if they are 

early or late. 

For Example If you set a grace period of 15 minutes, an asset can be at a POI 15 
minutes before it opens, or 15 minutes after it closes, without being considered to 

have a curfew violation. 

6.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

7.  Choose the POI Category to which POIs must belong to appear in the report. 

8.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 

generating. 
 

Distance Report 
 

What the Report Shows 

For each selected asset that has asset activity during the reporting period, shows distance 

travelled by date and location (province/state), including: 

• length of time the ignition and PTO were on 

• total distance travelled within a province/state each day 

• distance travelled on private roads 

• run, resource/crew, and related asset to which the asset was assigned during the 
reporting period 

• custom fields related to the asset 



Fleet Complete User Guide 88 

Working with Operations Reports Fleet Reports  

 

 

 
 

How to Generate Report 

1.  On the Reports— Operations screen, click Report > Fleet > Distance. 

2.  From the top list, choose what you want reported: assets, runs, related assets, 
resources/crews, or asset or resource types. 

3.  Select one or more items to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 

schedule(s) of the asset(s), or just data collected outside the work schedule(s) of the 
asset(s). 

6.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 

 

DTC Report 
 

What the Report Shows 

This report requires that assets have an ECM device. 

For each selected asset that had a Diagnostic Trouble Code (DTC) detected during the 

reporting period, shows: 

• asset name and type 

• resource and related asset to which the asset was assigned during reporting period 

• DTC's description and code 

• date and time the DTC was detected 

• number of times the DTC was detected during reporting time 

• values of custom fields 

Expand a record to show DTC details, such as the speed at which the asset was travelling, air 

pressure, oil temperature, etc. 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > DTC. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Click Get Data. The report appears in a grid on the right. 
 

Event Report 
 

What the Report Shows 

This report requires that rules be configured. 

For each selected asset, shows details about each event that occurred in the reporting 
interval, including: 

• name of the event, when it started and ended, and when it was triggered 

• name of the sensor that was triggered and its value during the event 

• duration of the event 

• speed of the asset at the time of the event and the posted speed limit in force at that 
time 

• where the event took place — start and end location, start and end POI (if any), start 
and end LSD (if any), latitude and longitude of both start and end location 
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• whether the event occurred during the asset's work schedule 

• whether there was a valid GSP reading at the time of the event 

• run, resource/crew, and related asset to which the asset was assigned during the 
event 

• values of custom fields for the asset 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Event. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 

schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Note: To see report results for a line item on the map, click Show on Map. 
 

Fleet Performance Report 
 

What the Report Shows 

Displays the number of events that occurred for the asset(s), and the number of maintenance 

items open for those assets, during the reporting interval. Also calculates an overall score for 
each asset/asset type based on the weighting established in system options. 

 

How to Generate the Report 

1.  On the Reports — Operations screen, click Report > Fleet > Fleet Performance. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Click Get Data. The report appears in a grid on the right. 
 

If necessary, you can click Cancel to stop the report generation process. This is useful if you 
realize you need to refine your report parameters before the report finishes generating. 

 

Idle Report 

This report applies only to in-vehicle devices with a valid ignition sensor. 
 

What the Report Shows 

For each selected in-vehicle device, during the report period, shows: 

• vehicle type of asset 

• length of the idle time (start time, stop time, and duration) 

• length of time PTO was ON 

• net amount and location of the idle time — address, POI (if any), LSD (if any), latitude 
and longitude 

• whether the idle time occurred during the asset's work schedule 

• whether there was a valid GPS reading when idling was detected 

• run, resource/crew, and related asset to which the asset was assigned during the idle 
time 
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How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Idle. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Enter the Minimum Idle Time duration: idle times below this limit do not appear on 
the report. 

7.  Click Get Data. The report appears in a grid on the right. 
 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

Note: To see report results for a line item on the map, click Show on Map. 
 

Input Report 

This report applies only to in-vehicle devices with sensors. 
 

What the Report Shows 

For every sensor connected to the selected asset within the reporting period, shows: 

• vehicle type 

• state of sensor 

• time the sensor state started and ended and how long the sensor remained in that 
state 

• whether the ignition was on during a sensor state 

• location where the sensor started and ended that state — address, POI (if any), LSD 
(if any), latitude/longitude 

• whether the sensor state occurred during the asset's work schedule 

• whether there was a valid GPS reading when the sensor state started 

• run, resource/crew, and related asset to which the asset was assigned during the 
sensor state 

• values of custom fields related to the asset 
 

How to Generate the Report 

1.  On the Reports — Operations screen, click Report > Fleet > Input. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  By default, the report includes data only when sensors have been enabled (such as a 
light beacon powered on). To also include the default input state (such as a light 
beacon powered off), check Include Default State. 

7.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

Note: To see report results for a line item on the map, click Show on Map. The start 

and end of the input state are shown with flag icons. 
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In addition to the usual Show on Map function, this report also includes a Visualizer 

which allows you to see on a map where the sensor had a state change. 
 

Last Position Report 
 

What the Report Shows 

For each selected asset, during the report period, shows: 

• phone number associated with the asset 

• asset's status (as shown in the Map Items panel on the Tracking screen) 

• date and time the asset reached its last position 

• if the asset was moving at the time of the report — the maximum speed of the asset, 
the posted speed limit in force at its location, the distance the asset had travelled 
since the ignition was turned on, and the heading (degree) and direction the asset was 
travelling 

• latitude and longitude of the asset's last position 

• address of the asset's last position — latitude/longitude, address, POI (if any) 

• run, resource/crew, and related asset to which the asset was assigned at the time 

• whether the GPS was valid at the time of the snapshot 

• LBS accuracy and description of the asset's last position, if applicable 

• LSD of the asset's last position (if any) 

• whether the last position was reported during the asset's work schedule 

• whether the asset was on a private road 

• state of the PTO (if any) 

• battery level (level of the power source connected to the device) 

• alarm, if any, indicating a code error such as movement with no ignition 

• values of any custom fields for the asset 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Last Position. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Note: To see report results for a line item on the map, click Show on Map. 
 

Maintenance Report 
 

What the Report Shows 

This report requires that maintenance be configured. 

For each maintenance item associated with the selected asset or asset type, shows: 

• e-mail recipients for the reminder 

• cost of the maintenance item 

• service schedule of the item 

• asset and asset type being maintained 

• category of the maintenance 

• status of the service 

• date the service was completed 

• odometer reading and/or operating hours of the asset at the time the service was 
completed 

• when the maintenance item was created 

• values of any custom fields for the asset 



Fleet Complete User Guide 92 

Working with Operations Reports Fleet Reports  

 

 

 
How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Maintenance 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Non-Transmit Report 
 

What the Report Shows 

For each asset that failed to transmit data for the specified duration of time, shows 

information about the last snapshots received, including: 

• date and time snapshots occurred 

• elapsed time since last snapshot 

• location — latitude/longitude, POI (if any), address of last snapshot transmission 

• whether the GPS was valid during the last transmission 

• state of the ignition when the last transmission occurred 

• current state of the asset 

• LSD (if any) 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Non-Transmit. 

2.  Choose the Duration of the non-transmit state: any asset, of any type, that was 
offline for that number of hours is included in the report. 

3.  Click Get Data. The report appears in a grid on the right. 
 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

Note: To see report results for a line item on the map, click Show on Map. 
 

POI Report 
 

What the Report Shows 

This report requires that POIs be configured. 

For each selected asset and POI, shows: 

• POI name, type, and category 

• time asset entered ("from" time) and exited ("to" time) the POI 

• amount of time asset was stopped or idling while at the POI 

• duration of time the asset spent in the POI 

• run, resource/crew, and related asset to which the asset was assigned during the 

reporting period 

• values of any custom fields associated with the asset and/or POI 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > POI. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 
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5.  Choose whether the report should include all data, just data collected during the work 

schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Choose the POI Category to determine which POIs appear in the report. 

7.  Enter the Minimum Duration (in minutes) that an asset needed to have been inside 
the POI in order to be included in the report. 

8.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Note: To see report results for a line item on the map, click Show on Map. 
 

Position Report 
 

What the Report Shows 

For each selected asset, asset type, run, resource/crew, or resource type, shows each 
snapshot of data taken during the reporting period, including: 

• asset and asset type 

• vehicle type 

• date and time of snapshot 

• asset's maximum speed during the snapshot 

• posted speed limit during the snapshot 

• distance travelled since the previous snapshot 

• asset's heading and direction 

• address where asset was at time of snapshot — latitude/longitude, POI (if any, 
address, LSD (if applicable) 

• run, resource/crew, and related asset to which the asset was assigned during the 
snapshot 

• whether the GPS was valid during the snapshot 

• state of ignition at the time of the snapshot 

• accuracy of LBS, if applicable 

• state of ignition and PTO (if any) at the time of the snapshot 

• reason code 

• whether the snapshot occurred during the asset's work schedule 

• whether the asset was on a private road 

• values of the asset's sensors 

• strength of GPS signal 

• odometer reading 

• current (from reported snapshot) and previous (from previous snapshot) asset status 

• values of any custom fields for the asset(s) and resource(s) 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Position. 

2.  From the top list, choose what you want reported: assets, runs, related assets, 

resources/crews, or asset or resource types. 

3.  Select one or more items to be included in the report. 

4.  Choose the date range for the report. 

We Recommend Since this report shows every snapshot for the selected assets in 

the reporting period, use a relatively short date range to speed up report generation. 
If you plan to use the Visualizer, we suggest you restrict the report to a single day, 
since data is not differentiated by day on the Visualizer. 

5.  Choose the time range for the report. 
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6.  Choose whether the report should include all data, just data collected during the work 

schedule(s) of the asset(s), or just data collected outside the work schedule(s) of the 
asset(s). 

7.  If you want the report to contain only data collected during the specified times (for the 
selected date range), click Time Slice. Otherwise the report will include data from the 
24 hours between the first specified time on the first date to the last specified time on 

the last date. 

For Example You run a position report for any workhours with a date range of 

Monday April 30 to Wednesday May 2, and a time range of 9 am to 5 pm, without the 
time slice option. The results show data from: 
Monday 9 am to 11:59 pm 

Tuesday 12:00 am to 11:59 pm 

Wednesday 12:00 am to 5:00 pm 
 

With the time slice option, the results show data from: 
Monday 9 am to 5 pm 

Tuesday 9 am to 5 pm 

Wednesday 9 am to 5 pm 

8.  Click Get Data. The report appears in a grid on the right. 
 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

Note: To see report results for a line item on the map, click Show on Map. 
 

This report also includes a Visualizer that can be used to see and compare the paths 
taken by each asset. 

 

PTO Usage Report 

This report applies only to in-vehicle devices with PTO sensors. 
 

What the Report Shows 

For each selected asset, and each PTO sensor associated with that asset, within the reporting 
period, shows: 

• asset name and type 

• state of PTO sensor 

• vehicle type 

• time the PTO sensor state started and ended and how long the sensor remained in 
that state 

• state of ignition 

• location where the sensor started and ended that state — address, POI (if any, LSD (if 
any), latitude/longitude 

• whether the sensor state occurred during the asset's work schedule 

• whether the GPS was valid when the PTO state started 

• run, resource/crew, and related asset the asset was assigned to during the state 
change 

 

How to Generate the Report 

1.  On the Reports — Operations screen, click Report > Fleet > PTO Usage. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 

schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 
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6.  Choose whether or not to include just PTO ON states. If the option is checked, the 

report shows only durations where the PTO state was "ON". If cleared, the report will 
show both ON and OFF durations (on separate lines). 

7.  Choose whether or not the report should break the PTO state duration based on 
ignition state, showing a separate line each time the ignition state changes. If this 
option is cleared, the report will not show an ignition state value. 

8.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Note: To see report results on the map, click Show on Map. The start and end of the 
input state change are shown with flag icons. 

In addition to the usual Show on Map function, this report also includes a Visualizer 

which allows you to see on a map where every sensor had a state change during the 
reporting period. 

 

Speeding Report 
 

What the Report Shows 

For any asset with an in-vehicle device that exceeded the posted speed limit or a specified 
speed during the reporting interval, shows: 

• start and end time of speeding occurrence 

• duration of speeding occurrence 

• address at which the occurrence began 

• maximum and average speed reached for the duration of the occurrence 

• posted speed limit at the time the occurrence began 

• POI, if any, where the occurrence began 

• LSD, if any, where the occurrence began 

• latitude/longitude where the speeding began 

• whether the speeding began during the asset's work schedule 

• whether the GPS was valid at the time the occurrence began 

• run, resource/crew, and related asset to which the asset was assigned during the 
asset's activity 

 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Speeding. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Choose the speeding level that warrants an asset being included in the report: 

• travelling at or over a specific speed 

• travelling in excess of the posted speed limit by a value (km/h or mph) or a 
percentage. 

7.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Note: To see report results for a line item on the map, click Show on Map. 
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Stop Report 

This report applies only to in-vehicle devices with a valid ignition sensor. 
 

What the Report Shows 

For the selected asset and reporting interval, shows: 

• the vehicle type 

• when the stop began and ended, and its duration 

• idle duration, if applicable 

• the location of the stop — address, POI code (if any), LSD (if any), latitude/longitude 

• whether the stop occurred during the asset's work schedule 

• whether the GPS was valid when the stop began 

• run, resource/crew, and related asset to which the asset was assigned during the 
stoppage 

• values of custom fields during the reporting interval 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Stop. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Choose the minimum length of time the asset needs to be stopped to appear in the 
report. 

7.  To have data include stops with engine running, check Ignore Ignition State. 

8.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Note: To see report results for a line item on the map, click Show on Map. 
 

Time Card Report 
 

What the Report Shows 

For each resource/crew on each working day in the reporting period, shows: 

• configured work schedule 

• login and logout time 

• number of breaks taken 

• total amount of time on breaks 

• amount of time working 

• resource type 

If a resource switched devices during the reporting period, their logout from one device and 
login to another are both shown. 

 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Time Card. 

2.  From the top list, choose whether you want to report on Resources/Crews or 

Resource Types. 

3.  Select one or more resources/crews (or resource types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Click Get Data. The report appears in a grid on the right. 
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If necessary, you can click Cancel to stop the report generation process. This is useful if you 

realize you need to refine your report parameters before the report finishes generating. 
 

Trip Report 

This report applies only to in-vehicle devices with a valid ignition sensor. 
 

What the Report Shows 

For the selected asset/type and reporting period, shows: 

• vehicle type 

• time ignition went on and off 

• time asset moved and stopped 

• amount of delay between ignition on and moving 

• amount of idle time during the trip 

• amount of moving time during the trip 

• average and maximum speed of asset during the trip 

• total distance travelled during trip 

• duration of trip from ignition on to ignition off 

• start and end location of trip — address, latitude/longitude, POI, POI code (if any), 
LSD (if applicable ) 

• whether the trip occurred during the asset's work schedule 

• whether the GPS was valid at the start and end of the trip 

• run, resource/crew, and related asset to which the asset was assigned during the trip 

• if the asset is equipped with an ECM device, the fuel economy rating for the trip 

• the values of any custom fields for the asset 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Trip. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Choose whether the report should include all data, just data collected during the work 
schedule of the asset(s), or just data collected outside the work schedule of the 
asset(s). 

6.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 

Note: To see report results for a line item on the map, click Show on Map. 
 

Unknown Movement Report 
 

What the Report Shows 

For the selected asset or asset type, during the specified dates, shows: 

• distance travelled 

• whether or not the GPS was valid at the time of the movement 

• reason code in effect during the reporting interval 

• elapsed time 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Unknown Movement. 

2.  Select one or more assets (or asset types) to be included in the report. 

3.  Choose the date range for the report. 
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4.  Choose whether the report should include all data, just data collected during the work 

schedule(s) of the asset(s), or just data collected outside the work schedule(s) of the 
asset(s). 

5.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 

if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Note: To see report results for a line item on the map, click Show on Map. 
 

Unvisited POIs Report 
 

What the Report Shows 

This report requires that POIs be configured. 

For each POI in the selected category and date range, shows: 

• asset/asset type that last visited the POI 

• POI name, type, and category 

• date/time POI was last visited 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Un-visited POIs. 

2.  Choose the date range for the report. 

3.  Choose the POI Category to determine which POIs appear in the report. 

4.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

 

Who Was There Report 
 

What the Report Shows 

For the specified location, during the specified dates, shows: 

• what assets were at that location, and their type 

• date and time the asset was at that location 

• latitude and longitude of the asset at that time 

• run, related assets, and resource assigned to the asset at the time 
 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Who Was There. 

2.  Choose the date range for the report. 

3.  Choose whether the report should include all data, just data collected during the work 
schedule(s) of the asset(s), or just data collected outside the work schedule(s) of the 
asset(s). 

4.  Enter the Latitude/Longitude, or Address/LSD of the location. 

5.  Enter the Buffer: an asset will be considered to have been at the location if it is within 
this buffer. 

6.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 

Note: To see report results for a line item on the map, click Show on Map. 
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Work Schedule Report 
 

What the Report Shows 

For the specified assets and date range, shows: 

• resource/crew assigned to the asset at the time 

• asset type 

• date and day of week of the schedule 

• total length of time the ignition was on during the work scheduled day 

• PTO duration during the work schedule day 

• scheduled start and end times to the work schedule on that day 

• when the asset's ignition was first turned on that day, and if that occurred within the 
work schedule 

• when the asset first moved on that day, and if it occurred within the work schedule 

• amount of idle time from first ignition to first movement 

• whether the asset's movements started during the work schedule 

• elapsed time between the scheduled start and the first movement of the asset 

• when the asset's ignition was last turned off that day, and if it occurred within the 
work schedule 

• resource/crew, run, and related assets associated with the asset at the time 

• location (address, POI, if any) where the asset first started the ignition on the work 
scheduled day 

• total distance the asset travelled during the work scheduled day 

• total asset costs incurred during the work schedule day — calculated as the hourly 

cost of the asset (number of hours between first ignition on and last ignition off 
multiplied by the hourly cost of the asset's vehicle type) plus the mileage cost of the 
asset (total distance travelled multiplied by the mileage cost of the asset's vehicle 
type) 

• total resource costs incurred during the work schedule day — calculated as the 
number of hours between first ignition on and last ignition off, multiplied by the 
resource's hourly cost (if any) 

• total idle time (total time between first ignition on and last ignition off) during the 
work schedule day 

• net idle time (total idle time minus the idle time that occurred while PTO was ON) 

during the work schedule day 

• values for custom fields during the report date range 

Note: This report reflects the current work schedules for assets. If the work schedule has 
changed, data from before the change will not be represented. 

For Example During the month of July, assets of the type "day shift" had a work schedule of 
9:00 am to 4:00 pm. In August, it was decided to expand the work schedule to include the 
half hour before and after work. If a report is run for both July and August, the report 

schedule calculation will be based on the current schedule (Monday to Friday 8:30 am to 4:30 
pm) rather than the schedule in effect when the data was collected. 

 

How to Generate Report 

1.  On the Reports — Operations screen, click Report > Fleet > Work Schedule. 

2.  From the top list, choose whether you want to report on Assets or Asset Types. 

3.  Select one or more assets (or asset types) to be included in the report. 

4.  Choose the date range for the report. 

5.  Click Get Data. The report appears in a grid on the right. 

If necessary, you can click Cancel to stop the report generation process. This is useful 
if you realize you need to refine your report parameters before the report finishes 
generating. 
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WORKING WITH MANAGEMENT REPORTS (BETA FEATURE) 
 

Background 
 

About the Management Reports Function (Beta Feature) 
 

Why Use This Function? 

Management reports provide information that is of particular interest to management, such as 
resource performance and utilization. These reports are most useful in environments where 
branching has been configured. 

Unlike Operations reports, Management reports show consolidated data that is retained for a 
contracted period of time. 

Note: For this release, Management reports should be considered a beta feature. 
 

What is the Default Configuration? 

A full set of Management reports is provided by default. 
 

What Do I Need to Understand About Management Reporting? 

Unlike in Operations reports, you do not choose specific assets or resources for Management 

reports: these reports include data for all assets and resources to which you have access. 
Report parameters determine the scope of data shown in the report: day, week, month, 
quarter, fiscal year, or year to date. 

Reports can be produced on-demand or can be scheduled. 
 

What Do I Need to Understand About Ranking? 

Two management reports (Resource Type Ranking Per Branch Level and Team Driver Ranking 
Weighted) use the concept of "ranking", which allows you to determine the relative importance 
of these events: 

• Speeding (Speed Limit) 

• Racing 

• Idle 

• Braking (Harsh Braking) 

• Acceleration (Rapid Acceleration) 

• Cornering (Harsh Cornering) 

• Open Maintenance Item 

How these events are ranked when displayed in Management reports is defined in the system 
options. 

For Example 

In your organization, you are more concerned about your delivery vehicle assets speeding 
than you are with them idling. As a result, you want each speeding event to count twice as 
much as each idling event. You configure idling as "1", and speeding as "2". If an asset has 2 
idling events and 2 speeding events in the reporting period, their overall score is 6: 2 points 
for the idling and 2 x 2 for the speeding. An asset with 4 idling events and 2 speeding events 

has an overall score of 8, whereas an asset with 2 idling events and 4 speeding events has an 
overall score of 10. 
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Opening the Management Reports Screen 

On the ribbon toolbar or main menu, click Reports > Management. 
The Reports — Management screen opens. 

 

 
 

About the Management Reports Screen 

The Management Reports screen is made up of the following elements: 

• a Fleet menu from which you can choose a report 

• a Report Parameters panel used to set the report parameters 

Note: Once you have set the parameters for one report, Fleet Complete applies those 
parameters, by default, to all subsequent reports until you exit Fleet Complete. 

• the output of the selected report, with a toolbar of formatting options and a button for 
scheduling generation of the report 

Note: To generate a report, click Get Data. 
 

About Scheduling Management Reports 
 

Why Use This Function? 

Once you have established which reports are most useful to your organization, scheduling 
them ensures that those reports are generated automatically and e-mailed to the appropriate 
contact. The same report can be scheduled in different ways for different purposes, such as for 
different audiences or to include different groups of information. 

 

What is the Default Configuration? 

No reports are scheduled by default. 
 

What Do I Need to Understand About Report Scheduling? 

Report schedules specify: 

• how frequently the report is to be generated 

• to whom the results should be sent 

• in what format the report should be produced (PDF, Excel, etc.) 

The data shown in a scheduled report will vary depending on what resource/asset data the 
recipient can access. For example, a scheduled report received by a district manager who has 
access to data only for their district will contain different details than that received by a 
regional manager who has access to data from several districts. 

Scheduled report results are e-mailed as attachments to a message which includes information 
about the current report. The message also tells the recipient when they will receive the next 
report. 
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Available Management Reports 
 

Use this report To... 
 

Asset Utilization see how efficiently assets are being utilized and compare utilization 
across asset types 

 

Driver Behaviour 
Incidents 

 

see which resources or resource types are responsible for events 
associated with driver behaviour and compare the results to other 
resources or resource types in the branch/company 

 

Monthly Team 
Average 
Summary 

 

compare the performance of individual resource types in each of the 
selected supervisor's teams to the average for the team on a number 
of important measures, including driver behaviour events and average 
shift start/end time 

 

Resource Type 

Ranking Per 
Branch Level 

 

compare the performance of resources across the branch/company, 

using the rankings established, in system options, for different types 
of events 

 

Resource 
Utilization 

 

see resource utilization totals for individual resources as well as totals 
and average for their resource type and  team 

 

Team Driver 
Ranking 
Weighted 

 

compare the performance of individual resource types and resources 
in all of the selected supervisor's teams, using rankings established in 
system options 

 

Asset Utilization Report 

Shows, in tabular format, for each asset: 

• how much time they were in the field (away from their home base) 

• how much time they were working/not working ("working" is defined in system 
options) 

• the distance they travelled (and the associated odometer readings) 

• what percentage of the possible time they were utilized 

• the maximum number of maintenance items that were open, and the total number 
that were closed, during the reporting interval 

For each asset type, the table shows distance and utilization totals, and averages for all asset 
values. 

Any values that are below the target utilization percentage configured for the asset's vehicle 
type are highlighted (for assets without a vehicle type, expected utilization is 0%). 

The report also shows total and average values for the branch/company. 

You can choose to display two additional charts, showing the average utilization of the five 
least and five most utilized assets in the branch/company. 

 

Driver Behaviour Incidents Report 

Shows a table and bar chart representing the total number of harsh braking, harsh cornering, 
racing, and speeding events that occurred in the branch/company during the reporting 

interval, and the number attributable to each resource type. Optionally, you can show this 
data organized by the resource associated with the event. 

For each sub-branch, shows: 

• a bar chart of the number of events attributable to each resource type 

• a pie chart showing the relative proportion of events of different types for the sub- 
branch 

• a pie chart showing the relative proportion of events attributable to each resource type 
in the sub-branch. 

Optionally, you can show this data by resource. 
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Also includes a table showing the number of each event attributable to each resource, and a 

bar chart showing the top best and top worse performing resources. 
 

Monthly Team Average Summary Report 

For each team supervised by the selected supervisor, shows data for each resource type that 
is part of the team, as well as the average for the team. Data is shown, in a bar chart, for: 

• speeding, harsh braking, harsh cornering, rapid acceleration, and racing events per 
distance (set in system options) 

• idle time 

• time during which PTO was engaged (if applicable) 

• actual shift start and shift end time (not work schedule) 

The definition of when a resource is idle and when it has PTO engaged is set in system 
options. 

 

Resource Type Ranking Per Branch Level Report 

Shows data for each resource type in the branch/company, in the following forms: 

• a table showing the weighted score (using the rankings set in system options) for each 
resource type, grouped by sub-branch, and the percentage of distance driven by all 
resources in the branch that is attributable to that type 

• a bar chart showing, for each sub-branch, the weighted score of each resource type on 
a number of factors, including 

• speeding, harsh braking, harsh cornering, rapid acceleration, and racing 
events per distance (set in system options) 

• time between shift end and arriving back at home base 

• idle time 

• total of all the reckless driving incidents (shown in earlier bar charts) 
 

Resource Utilization 

Shows, in tabular format, for each resource: 

• average start time (average time arrived at first stop after commute from home) and 
end time (average time left last stop for commute home) 

• the total duration of the resource's work time, travel/stop time, and commute time 

• average travel (excluding commute) and stop time 

• the total and average trip distance for the resource 

• the percentage of the resource's time spent in travel (ratio of travel time to total time 
in field) 

• the total cost of the resource, and the amount attributed to ravel and on site time (on 
site time is any time not at home base) 

Any values that are above the maximum travel duration configured for the resource are 
highlighted (for resources without a maximum travel duration, expected utilization is 0%). 

For each resource type and crew, the table shows the total work duration and cost, as well as 
the average values for other data. 

You can choose to show or hide a pie chart for each resource included in the report, showing a 
breakdown of their total time in the field (proportion of that time spent in travel, commute, 
etc.). 

 

Team Driver Ranking Weighted Report 

Shows, in chart and tabular format, the weighted score (using the rankings set in system 
options) for each resource type in the selected team, the percentage of the team's total 
distance driven attributable to that type, and the number of incidents (events) per configured 
distance for the type. 
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Management Reports Functions 
 

Generating Management Reports 
1.  On the Management Reports screen, click Fleet > [name of report]. 

2.  If applicable, choose the Supervisor whose service groups should be included in the 
report. 

3.  Choose the time period for the report. 

• Day or Week (click on the appropriate day or week in the calendar) 

• Month or Quarters and Year (choose from the available lists) — quarters are 
configured in system options 

• Year to date (calendar year) 

4.  Click Get Data. The report appears on the right. 
 

Scheduling Management Reports 

1.  On the Management Reports screen, click Fleet > [name of report]. 

2.  If desired, change the default parameters for the report. 

3.  Click Schedule. 

The Management Report Schedule screen opens. 

 
 

4.  The schedule's Description defaults to the name of the report. 

5.  Choose the Export Format to be used for scheduled report output. 

6.  Choose one or more report schedules (daily, weekly, etc.). Daily scheduled reports will 

be produced at 12:00 PM local time. All other scheduled reports will be produced at 

1:00 PM local time. 

7.  For each report schedule, choose who should receive the report output (by default, 

report output is sent to you). To add a recipient, click Add and choose a user from the 
Add Subscriber list. 

Note: The History tab shows details about when the scheduled report was generated. 
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Working with Management Report Output 
 

To... Do this... 

 
choose page size, margins, and   
orientation for printed report output choose File > Page Setup or click 

 

print the displayed report to a 

selected printer or to the default 
printer (QuickPrint) 

choose File > Print or click    (prompted for 

printer) or  (quick print) 
 

export the displayed report to a 

specific format file (e.g. PDF, text, 
etc.) 

 

choose File > Export Document > file format or 

click  

 

view multiple pages of the report  
simultaneously click and choose from the various options 

or click  and choose the appropriate settings 
 

choose to show report output as 
separate pages or as one continuous 
scrolling page 

 

choose View > Page Layout > Facing or 
Continuous 

 

scroll through the current displayed  
page(s) of the report use the scroll bars or click and click on the 

report output 
 

zoom in or out use the slider at the bottom right of the screen 

use the zoom controls  

click  and double-click on the report output 

(zooms to 100%) 
 

search for text in the report 
 

click  and enter the text to be searched for (the 

area of the report containing the text is highlighted 
by a box 

 
choose coloured background for the   

displayed report choose Background > Color > or click  and 
choose from the available colors 

 
add a watermark to the report   

output choose Background > Watermark or click 
and specify the characteristics of either a text or 

picture watermark 

 
Customizing Management Reports 

You can customize Management reports to suit your purposes. Once you have generated any 
report, click Copy. You can then modify the report’s layout and content, and save it as a new 

report. 

The custom report is listed in the User Reports menu (which appears once you have created 
a custom report). 
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TROUBLESHOOTING 
 

Contacting Technical Support 
To contact Fleet Complete technical support: 

• call 1-800-220-0779 extension 2 

• email support 

• fax to 905-470-9434 

• visit our web site — a link to this site is installed with the product (click Fleet 

Complete online support from your Start menu) 
 

 
When communicating with technical support, please be sure to include in your message: 

• your client name and client ID 

• who to contact at your organization and how to contact them 

• detailed description of the problem, including what you were doing when it occurred 

• description of asset involved, if any 

• any attempts you have made to resolve the problem 
 

 
It can also be helpful to provide an exported/printed copy, or a screenshot, of the grid in use 
when the problem occurred. 

 

Solving Common Problems 
 

Connection Problems 
Ensure that the bottom of your Fleet Complete screen indicates that all information is up to 
date. If it says "disconnected", your system may be offline, or there may be a problem with 
your internet connection. Try closing Fleet Complete and running it again. 

 

Function Visibility Problems 
If you change a user account to allow users to receive alerts or MDT messages, but the user 
does not see the appropriate window, it may be necessary to Restore Default Settings. 

Warning: All customizations will be lost. 

Close Fleet Complete and start it again. On the login page, click Restore Default Settings. 

This removes any customization, but leaves data intact. Specifically, it will: 

• remove show/hide settings from the Tracking screen map 

• remove all groupings and filters from grids (including report output layouts) 

• remove labels from all mapped items 

• restore the Report Dashboard to default layout 

 

Using a Proxy 
If you cannot connect to the remote server when you log in, you may need to configure your 
proxy server. This needs to be done only once. 

1.  On the login page, click Proxy Configuration. 

The Proxy screen opens. 

2.  To use your default Windows Internet settings, check Use Default Credentials. 

To use a custom proxy, check Use Custom Proxy Settings and enter the appropriate 

Server IP address (being sure to include http://) and Port. 

3.  Click Save. 
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An activity is a simple task (such as a service call or delivery) that a resource does at a 
specific location. 

An alarm state occurs when an asset moves with its ignition off, which may indicate an 

attempted theft — alarms automatically trigger an alert and are shown on the Map Items 
panel of the Tracking screen. 

An alert appears (as a pop-up, to any user whose account is set to receive them) whenever 

an event that includes an alert notification occurs. 

An asset is an in-vehicle or handheld device that has GPS. 

An asset activity is any change in ignition or other sensor state, or any GSP-related activity 
such as stopping, moving, or arriving at/departing a POI. 

In Fleet, "assign" means "associate" — for example, assets are assigned to asset types. 

Branches are an optional feature; if not implemented, all your data is stored under a single 
company branch. 

A commute is the time/distance between home base and the first POI of the day, and the 
time between last POI of the day and home base. 

A contact is an individual who is not defined as a Fleet Complete user or resource but who 
you want to keep informed of specific circumstances. 

A crew is a group of resources. 

Custom fields are used to record and display information beyond what is provided by default 
in Fleet Complete. 

Data Conservation Mode (DCM) ensures an asset communicates with Fleet Complete only 
when necessary; the asset communicates when the ignition is on, during the 12 minutes after 
it has been turned off, and whenever a significant GPS movement (1000 metres or more) 
occurs. 

A driver is another name for a resource. 

DTC is Diagnostic Trouble Code. 

An ECM box is an in-vehicle device that records specialized information (fuel consumption, 
vehicle health, specific driver behaviours) which is shown in ECM reports. 

An event occurs when a rule is triggered; events appear in the Events area of the map details 
panel and in the Event report. 

A driver ID Fob is a small security tag with built-in authentication, used to identify a resource 
who is operating an asset that has an in-vehicle device. 

A resource or crew's home base is the POI where the asset or resource is assumed to begin 

and end their work day. 

Idle is when an asset with an in-vehicle device is still, with the engine running. 

LBS (Location Based Service) determines a hand-held asset's location based on cell tower 

readings. 

LSD (Legal or Land Subdivision) is a type of location applicable mostly for Alberta, Canada. 

The main menu appears when you click . 

MDT refers to an external device, such as a Garmin device, that is integrated with Fleet 
Complete and allows for two-way communication between drivers and Fleet Complete users. 

Notification is a collective term for an alert and/or e-mail message. 

A Point of Interest (POI) is a geographical location of particular interest to your 
organization, which is identified with a name and, optionally, a code. 

PTO (Power Take Off) is a specific input that can indicate the work activity of equipment using 
an alternate power source (e.g. boom arm on tow truck). 
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A resource is an individual (not necessarily a Fleet Complete user) who is assigned to an 

asset for activity, MDT, or driver ID FOB purposes. 

The ribbon toolbar is the toolbar that appears across the top of the interface. 

Rules are used to monitor the behaviour of assets and/or the readings of their sensors; when 
triggered, rules cause an event. 

A sensor is an optional addition to a vehicle's data collection that can identify specific actions 

related to the vehicle, such as whether a light beacon is on, a security door is open, or a tow 
arm is up or down. 

A service group is a logical grouping of resources and crews. 

A snapshot is the data collected for an asset, at intervals determined by the asset's device 
data settings. 

An asset is "stopped" when an asset has a speed of 0 and, for a in-vehicle device, the ignition 
is off. 

A team refers to all resources/crews who belong to a service group with the same supervisor. 

A trip is the travel of an asset from ignition on to ignition off or, for ECM, from engine on to 
engine off. 

An asset's vehicle type is used to specify the running costs for the vehicle and its maximum 
weight; used for reporting. 

A work schedule specifies the hours during which an asset or resource is expected to be 

working; used to separate personal from working hours for analysis purposes. 

Working hours are the hours of operation specified for a POI. 
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